Chapter 1  
**Getting started**  
About FileMaker Pro Advanced  
- Design and develop customized, advanced databases  
- Debug and troubleshoot database solutions  
- Maintain and modify databases  
New features in FileMaker Pro 8 Advanced  
- Schema sharing features  
- Customizing features  
- Debugging and troubleshooting features  
Using the FileMaker Pro Advanced documentation  
- Where to find PDF documentation  
Registration and customer support  
About the license key  
Abiding by the license agreement for runtime solutions  
About the TechInfo Knowledge Base  

Chapter 2  
**Customizing database solutions**  
Adding tooltips to layout objects  
Copying scripts, script steps, or fields  
Copying or importing tables into a file  
- Copying table schema  
- Importing table schema  
Using custom functions  
- Creating custom functions  
- Editing custom functions  
- Deleting custom functions  
- Duplicating custom functions  
About Kiosk mode  
- Navigating in Kiosk mode  
- Closing Kiosk solutions  
- Creating Kiosk solutions  
- Using scripts and buttons to control your solution  

Chapter 3  
**Customizing menus**  
About customizing menus  
- How custom menus affect other features  
- Custom menu terminology  
Customizing menus  
- Creating and editing custom menus  
- Creating and editing menu items  
Customizing menu sets  
- Creating and editing menu sets  
Installing menu sets  
- Specifying a default menu set  
- Specifying menu sets for individual layouts  
- Creating scripts to change menu sets  
Testing menu sets  
Using customized About, Help, or Script menus from previous versions  

Chapter 4  
**Creating custom layout themes**  
Modifying FileMaker Pro Advanced themes  
Requirements for theme files  
- Minimum XML elements for themes  
- Removing elements from theme files  
- XML elements for layout parts  
- XML elements for text
<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Developing third-party FileMaker plug-ins</th>
</tr>
</thead>
<tbody>
<tr>
<td>About external functions</td>
<td>43</td>
</tr>
<tr>
<td>About the example plug-in</td>
<td>43</td>
</tr>
<tr>
<td>Installing, enabling, and configuring the example plug-in</td>
<td>45</td>
</tr>
<tr>
<td>Description of the FMExample plug-in’s external functions</td>
<td>46</td>
</tr>
<tr>
<td>Using the example plug-in</td>
<td>46</td>
</tr>
<tr>
<td>Customizing the plug-in example</td>
<td>48</td>
</tr>
<tr>
<td>Customizing FMPluginExample.cpp</td>
<td>48</td>
</tr>
<tr>
<td>Customizing FMPluginPrefs.cpp</td>
<td>48</td>
</tr>
<tr>
<td>Customizing FMPluginFunctions.cpp</td>
<td>48</td>
</tr>
<tr>
<td>Requirements for writing external function plug-ins</td>
<td>49</td>
</tr>
<tr>
<td>API code files</td>
<td>49</td>
</tr>
<tr>
<td>Option string syntax</td>
<td>49</td>
</tr>
<tr>
<td>Naming conventions for external functions</td>
<td>50</td>
</tr>
<tr>
<td>FileMaker messages sent to the plug-in</td>
<td>50</td>
</tr>
<tr>
<td>Initialization message</td>
<td>50</td>
</tr>
<tr>
<td>Shutdown message</td>
<td>51</td>
</tr>
<tr>
<td>Idle message</td>
<td>51</td>
</tr>
<tr>
<td>Preferences message</td>
<td>52</td>
</tr>
<tr>
<td>External Function message</td>
<td>52</td>
</tr>
<tr>
<td>GetString message</td>
<td>52</td>
</tr>
<tr>
<td>Avoiding potential Mac OS X resource conflicts</td>
<td>52</td>
</tr>
<tr>
<td>Providing documentation for your plug-in</td>
<td>53</td>
</tr>
<tr>
<td>Registering your plug-in</td>
<td>53</td>
</tr>
<tr>
<td>Revising a registered plug-in</td>
<td>53</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Debugging, analyzing, and optimizing files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debugging and troubleshooting scripts</td>
<td>55</td>
</tr>
<tr>
<td>Stepping through scripts</td>
<td>55</td>
</tr>
<tr>
<td>Viewing sub-scripts</td>
<td>56</td>
</tr>
<tr>
<td>Monitoring fields, variables, and calculations</td>
<td>57</td>
</tr>
<tr>
<td>Disabling script steps</td>
<td>58</td>
</tr>
<tr>
<td>Documenting database schemas</td>
<td>59</td>
</tr>
<tr>
<td>Troubleshooting files with the DDR HTML output</td>
<td>60</td>
</tr>
<tr>
<td>Compressing and optimizing files</td>
<td>60</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Using the Developer Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of preparing your solution files</td>
<td>63</td>
</tr>
<tr>
<td>Modifying database solution files</td>
<td>64</td>
</tr>
<tr>
<td>Creating an error log</td>
<td>66</td>
</tr>
<tr>
<td>Considerations for a runtime database solution</td>
<td>66</td>
</tr>
<tr>
<td>Checking file references</td>
<td>67</td>
</tr>
<tr>
<td>Binding files for both platforms</td>
<td>68</td>
</tr>
<tr>
<td>Binding databases into runtime database solutions</td>
<td>68</td>
</tr>
<tr>
<td>Choosing filenames for runtime database solutions</td>
<td>69</td>
</tr>
<tr>
<td>Assigning three-character filename extensions</td>
<td>69</td>
</tr>
<tr>
<td>Setting the binding key</td>
<td>70</td>
</tr>
<tr>
<td>Modifying bound runtime files</td>
<td>71</td>
</tr>
<tr>
<td>Saving and reusing Developer Utilities settings</td>
<td>71</td>
</tr>
<tr>
<td>Modifying a set of solution settings</td>
<td>71</td>
</tr>
<tr>
<td>Converting and upgrading solution files</td>
<td>72</td>
</tr>
<tr>
<td>Importing data into upgraded runtime solutions</td>
<td>72</td>
</tr>
<tr>
<td>Removing full access privileges from databases</td>
<td>73</td>
</tr>
</tbody>
</table>
Chapter 8

Distributing runtime database solutions 75

Organizing solution components 75
  Mac OS X runtime application package 75
  DLL files for Windows runtime solutions 76
  Extensions folder for Windows solutions 76

Choosing a distribution method 76
  Reducing solution size 76
  Using a custom installation program 77
  Using a compression utility program 77
  Sharing solutions over a network 77

What your users need 77
  Documenting the installation procedures 78
  Starting runtime database solutions 78
  Recovering damaged files 78

Providing user documentation 79
  Creating an About layout 79
  Creating a custom Help layout 80
  Including printed documentation 81

Your responsibilities as a developer 82
  Testing before and after creating your solution 82
  Distributing updates to runtime database solutions 83

Appendix A

Feature comparison of the runtime application with FileMaker Pro 85

Application and document preferences 85
  Toolbar comparison 87
  Menu command comparison 87
  Ignored script steps 90
  Stored registry settings or preferences 91

Index 93
Welcome to FileMaker® Pro Advanced. This product includes advanced development and customization tools designed especially for database developers. You can use either FileMaker Pro or FileMaker Pro Advanced to create and test your database solutions.

**About FileMaker Pro Advanced**

FileMaker Pro Advanced includes all the features and functionality of FileMaker Pro plus tools that help you do the following:

**Design and develop customized, advanced databases**

- Create custom menus to suit the needs of your database and users. See “Customizing menus” on page 21.
- Add custom tooltips to layout objects to make your database more intuitive and to guide data entry. See “Adding tooltips to layout objects” on page 11.
- Create standalone runtime solutions. See “Binding databases into runtime database solutions” on page 68.
- Display your database in full-screen kiosk mode. See “About Kiosk mode” on page 16.
- Build centralized and recursive formulas with custom functions. See “Using custom functions” on page 14.
- Use external function plug-ins to extend and customize your solutions and use C++ in your calculations. See “Developing third-party FileMaker plug-ins” on page 43.

**Debug and troubleshoot database solutions**

- Monitor fields, variables, and expressions with the Data Viewer while debugging scripts or troubleshooting databases. Or, test calculations without modifying your database schema. See “Monitoring fields, variables, and calculations” on page 57.
- Use the Script Debugger to identify problem areas and review scripts step-by-step as they execute. See “Stepping through scripts” on page 55 and “Viewing sub-scripts” on page 56.
- Disable script steps to test portions of a script. See “Disabling script steps” on page 58.

**Maintain and modify databases**

- Copy entire scripts, specific script steps, or fields from one file and paste them into the same file or some other file. See “Copying scripts, script steps, or fields” on page 12.
- Consolidate tables from a multi-file solution into one file by copying or importing table schema. See “Copying or importing tables into a file” on page 13.
- Use the Database Design Report to gather comprehensive information on database schema and options like fields, tables, script steps, portals, merge fields, custom menus, and tooltips. The reports also help you troubleshoot missing references, broken relationships, calculations, and more. See “Documenting database schemas” on page 59.
- Use the File Maintenance tools to maximize performance and compact and recover unused space. See “Compressing and optimizing files” on page 60.
New features in FileMaker Pro 8 Advanced

FileMaker Pro 8 Advanced includes the following new features and improvements. For a complete listing of new features introduced in FileMaker Pro 8, see the FileMaker Pro User’s Guide or Help.

Schema sharing features

<table>
<thead>
<tr>
<th>For more information on this feature</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copying and importing tables across files or within the same file</td>
<td>“Copying or importing tables into a file” on page 13</td>
</tr>
<tr>
<td>Copying scripts, script steps, or fields</td>
<td>“Copying scripts, script steps, or fields” on page 12</td>
</tr>
</tbody>
</table>

Customizing features

<table>
<thead>
<tr>
<th>For more information on this feature</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding tooltips</td>
<td>“Adding tooltips to layout objects” on page 11</td>
</tr>
<tr>
<td>Creating custom menus</td>
<td>“Customizing menus” on page 21</td>
</tr>
</tbody>
</table>

Debugging and troubleshooting features

<table>
<thead>
<tr>
<th>For more information on this feature</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring fields, variables, and calculations using the Data Viewer</td>
<td>“Monitoring fields, variables, and calculations” on page 57</td>
</tr>
<tr>
<td>Viewing sub-scripts as you step through scripts</td>
<td>“Viewing sub-scripts” on page 56</td>
</tr>
<tr>
<td>Disabling script steps</td>
<td>“Disabling script steps” on page 58</td>
</tr>
</tbody>
</table>

Note: If your solution uses third-party plug-ins, contact your plug-in providers to confirm that their plug-ins work with FileMaker 8 products. The External Function Plug-in is backward-compatible, but a plug-in may rely on features that have changed from previous versions.

Using the FileMaker Pro Advanced documentation

This Development Guide is one component in a comprehensive documentation suite provided with FileMaker Pro Advanced. Some of the documents are provided in print and in portable document format (PDF), while others are available in PDF only. FileMaker Pro Advanced also includes an online Help system to provide details on FileMaker Pro features.

This guide includes information about features that are available with FileMaker Pro Advanced. It assumes that you are familiar with FileMaker Pro or FileMaker Pro Advanced, and that you have created a database solution that you want to work on using the FileMaker Pro Advanced features. If you are new to the FileMaker family, start with the FileMaker Pro User’s Guide.

Note: Throughout the documentation, when a feature or procedure is specific to a particular platform, you see instructions and illustrations that are also specific to that platform. For features or procedures that are similar on both platforms, you may see illustrations for either Windows or the Mac OS.
The following manuals are included:

- *FileMaker Pro Advanced Development Guide* (this manual): describes how to use the features available in FileMaker Pro Advanced
- *FileMaker Pro User’s Guide*: contains key concepts and basic procedures
- *Database Design Report XML Output Grammar* manual: describes the FileMaker Pro Advanced Database Design Report (DDR) XML output grammar for users who want to create tools that analyze or process the structure of databases
- *FileMaker Instant Web Publishing Guide*: describes how to make FileMaker Pro and FileMaker Pro Advanced databases accessible to web browser users over an intranet or the Internet
- *Installing FileMaker ODBC and JDBC Client Drivers*: describes how to install driver files for using FileMaker products with ODBC and JDBC applications
- *FileMaker ODBC and JDBC Developer’s Guide*: describes how to use ODBC and JDBC with FileMaker products

**Where to find PDF documentation**

Most PDF manuals are located in the folder where you installed FileMaker Pro Advanced. If you installed FileMaker Pro Advanced in the default folder location, the PDF manuals are located here:

- **Windows**: C:\Program files\FileMaker\FileMaker Pro 8 Advanced\English Extras\Electronic Documentation
- **Mac OS**: Macintosh HD/Applications/FileMaker Pro 8 Advanced/English Extras/Electronic Documentation

PDF manuals for ODBC and JDBC are on the FileMaker Pro Advanced CD, in the /xDBC/Electronic Documentation folder. To view the PDF files, you need a PDF reader. In Mac OS X, you can use either the built-in Preview application or Adobe Reader®. Windows users need Adobe Reader. If you do not have Adobe Reader, you can download it from the Adobe web site at www.adobe.com. **Important** You can download PDFs of FileMaker documentation from www.filemaker.com/downloads. Any updates to this document are also available from the web site.

All of the PDF files use the tagged Adobe Portable Document format (PDF). Tagged PDF files work with assistive technology such as the screen readers JAWS and Window-Eyes for Windows. For more information about tagged PDF files, see the Adobe web site at www.adobe.com.

**Registration and customer support**

Please take the time to register your product during installation, through the FileMaker web site at www.filemaker.com/register, or by choosing Help menu > Register Now in FileMaker Pro Advanced. For information about technical support and customer service, see: www.filemaker.com (North American customers) www.filemaker.com/intl (customers outside North America) or choose Help menu > FileMaker on the Web. At the web site, you will find the service options available to North American customers, as well as links to FileMaker worldwide sites, answers to frequently asked questions, and access to the TechInfo Knowledge Base used by Technical Support. If you do not have access to the internet, please refer to the FileMaker Service Directory included in the software box. North American customers can also call (800) 965-9090 to learn about the service options available.
**About the license key**

FileMaker software comes with a unique, 35-character-string license key. Do not lose this license key; it cannot be replaced. We recommend that you keep the license key in a safe place in case the software ever needs to be reinstalled.

**Important** You must enter the license key during installation or the software will not install.

The license key ensures adherence to the single user license agreement, which generally allows for use of one (1) copy of the Software on a single computer at a time (refer to your Software License). If the license key is invalid or if another copy of the application installed with that same license key is running on the network, the FileMaker Pro application displays this error message: “The maximum number of licensed users are currently using this copy of FileMaker Pro Advanced. Please refer to the License Key section of your software documentation for further instructions.”

If you receive this error message, you have entered a duplicate license key. To install FileMaker Pro Advanced on multiple computers, you must have a unique license key for each user, or obtain a volume license. You must license one copy of FileMaker Pro Advanced for each computer.

**Abiding by the license agreement for runtime solutions**

The FileMaker Pro Advanced license agreement allows you royalty-free distribution of an unlimited number of FileMaker Pro runtime database solutions. However, there are several terms and conditions in the license agreement you must abide by, including the following:

- You must provide all of the end-user technical support.

- You must provide an “About” layout that includes your name, address, and the telephone number for your technical support. For more information, see “Creating an About layout” on page 79.

**Note** You must read and agree to the terms and conditions of the FileMaker Pro Advanced license agreement, available through the FileMaker Pro Advanced installer, before using the FileMaker Pro Advanced software.

**About the TechInfo Knowledge Base**

The TechInfo Knowledge Base is a great resource for technical information about FileMaker, Inc. products. This FileMaker Pro database serves as a front-line resource for the company’s Technical Support staff as they field customer inquiries. It is a collection of Q&As, tips, FAQs, issue reports, update notes, press releases, and a host of other material valuable for the support professional.

The TechInfo Knowledge Base is available on the product support pages of the FileMaker web site at www.filemaker.com.
Chapter 2
Customizing database solutions

You can use FileMaker Pro Advanced to customize your solutions beyond what is possible with FileMaker Pro. You can:

- Add tooltips to provide information about layout objects
- Create custom functions for use anywhere within a file
- Copy and paste scripts, script steps, or fields for use within the same file or other database files
- Copy or import existing tables into your database file
- Create a solution that displays your database in Kiosk mode

Adding tooltips to layout objects

You can use FileMaker Pro Advanced to add tooltips to layout objects. Tooltips appear when a user moves the cursor over an object in Browse or Find modes. Tooltips can be static text or the results of a calculation.

To add, change, or delete tooltips:
1. In Layout mode, select the object to which you want to add a tooltip.
2. Choose Format menu > Set Tooltip.
   
   **Tip** You can also right-click the object and choose Set Tooltip.
3. Do the following in the Set Tooltip dialog box, then click OK:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a tooltip that displays static text</td>
<td>Type the text you want to appear.</td>
</tr>
</tbody>
</table>
| Create a tooltip that displays the results of a calculation | Click Specify.  
In the Specify Calculation dialog box, build a formula for your calculation. Click OK. |
| Change the tooltip             | Modify the tooltip text as required.                                   |
| Delete the tooltip             | Delete the tooltip text.                                               |

**Tip** In Layout mode, choose View menu > Show > Tooltips to identify objects with tooltips. Objects with tooltips display this icon in Layout mode.
Keep these points in mind:

- Tooltips display in FileMaker Pro, FileMaker Pro Advanced, runtime database solutions, and databases published to the web with Instant Web Publishing. You must use FileMaker Pro Advanced to add, edit, or delete tooltips.

- If you open a file containing an object with a tooltip in FileMaker Pro 7 or FileMaker Developer 7 and copy that object, when you reopen the file in FileMaker Pro Advanced, the tooltip icon appears without tooltip text for the copied object. Select the object, choose Format menu > Set Tooltip, then enter the tooltip text or click OK to remove the icon. Duplicating objects in FileMaker 7 retains the tooltip text.

- Tooltips display in Browse and Find modes and in Form view, List view, and Table view.

- You can select multiple layout objects to assign the same tooltip to each. When you select multiple objects, the Set Tooltip dialog box displays the tooltip for the top object.

- You can add a tooltip to grouped objects. All objects in the group will display the same tooltip.

- All calculation results display as text, including dates, times, and numbers.

- If the object’s tooltip calculation returns an empty string, no tooltip displays. For example, if your tooltip displays related data and the relationship is missing, the tooltip will be empty. If an error occurs in the calculation, the tooltip displays invalid or partially valid results with question marks.

- When you copy or duplicate an object with a tooltip, FileMaker applies the tooltip to the new object.

- Tooltip text wraps if it exceeds 40% of the width of the screen.

### Copying scripts, script steps, or fields

You can copy entire scripts, specific script steps, or fields from one file and paste them into the same file or some other file.

1. Do one of the following:

#### To copy a

<table>
<thead>
<tr>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
</tr>
<tr>
<td>Script step</td>
</tr>
<tr>
<td>Field</td>
</tr>
</tbody>
</table>

2. Select the script, script step, or field you want to copy.

3. Click Copy.

4. Open the appropriate dialog box in the file in which you want to paste the script, script step, or field you copied.

5. Click Paste.

   **Note** Select the script or script step after which you want the pasted script or script step to appear, and then click Paste.

Keep these points in mind:

- Pasted objects do not retain privileges. You must redefine privilege sets in the destination file.

- Open the Import.log file, normally located in the folder with your destination database, for details on unresolved references and items that were renamed due to a naming conflict. If you’ve opened the destination database remotely or do not have write access to that folder, check the My Documents folder (Windows) or Documents folder (Mac OS).
FileMaker Pro Advanced retains references to scripts, script steps, and fields if they are valid when you paste. If you copy multiple scripts, script steps, or fields that reference each other, copy them in one step to retain the references. If you copy them one at a time, the references may be lost. Check all references after pasting to ensure they are valid.

To copy and paste scripts, you must have write access to the source script and privileges to create scripts in the destination file.

To copy and paste script steps, you must have write access to the source and destination scripts.

To copy and paste fields, you must have full access privileges to the source and destination files.

When you copy scripts with disabled script steps, the steps remain disabled when pasted in the new location. For more information, see “Disabling script steps” on page 58.

When you copy scripts or script steps, breakpoints are not copied. However, when you duplicate scripts or script steps, breakpoints are retained.

Copying or importing tables into a file

With FileMaker Pro Advanced, you can consolidate tables from a multi-file solution into one file. There are two methods for consolidating solutions:

- Copy table schemas — Open source files to select and copy the tables you want. Then, paste the table schemas into the destination file.
- Import table schemas — Import table schemas directly into the destination file. You can import just the schemas or import data with a single schema. (To import the data with a single schema, choose File menu > Import Records > File. For more information, see Help.)

When you copy or import tables:

- FileMaker Pro Advanced retains references to tables, fields, and scripts if they are valid when you copy or import. If your tables reference each other through fields, copy or import the tables in one step to retain the references. If you copy or import them one at a time, the references may be lost. Check all references after pasting or importing to ensure they are valid.
- Open the Import.log file, normally located in the folder with your destination database, for details on unresolved references and items that were renamed due to a naming conflict. If you’ve opened the destination database remotely or do not have write access to that folder, check the My Documents folder (Windows) or Documents folder (Mac OS).
- You must have full access privileges to the source and destination files.
- Privileges from the source file are not retained. You must redefine privilege sets in the destination file.
- Relationships between table occurrences are not retained.
- You must convert database files from versions of FileMaker Pro earlier than 7.0 before importing tables. For more information about converting databases, see the FileMaker Pro User’s Guide.

Copying table schema

To copy table schema:

1. Open the database file that contains the table you want to copy.
2. Choose File menu > Define > Database > Tables tab.
3. Select the table you want to copy.
4. Click Copy.
5. Open the database file where you want to paste the table.
6. Choose File menu > Define > Database > Tables tab.
7. Click Paste.
Importing table schema

1. Open the database file into which you want to import a table.
2. Choose File menu > Define > Database > Tables tab.
3. Click Import.
4. In the Open File dialog box, select the source file.
5. In the Import Tables dialog box, select the tables you want to import from the list and click OK.
6. In the Import Summary dialog box, click Open log file to see a more detailed log of the procedure or click OK to close the dialog box.

Note: If you created fields or tables and want to import them into the same file, close the Define Database dialog box once before importing.

Using custom functions

Use the Custom Functions feature to create custom functions that can be reused anywhere in the database file in which they are created. Once formulas are written for the function, they don’t have to be rewritten to be applied to other fields or used in other scripts.

You can maintain and edit custom functions and the formulas they contain in one central location. Any change made to the custom function will be copied to all instances where that custom function has been used.

- Any users of the database file that contains a custom function can use the function if they have the proper permissions.
- Custom functions will run in both FileMaker Pro and FileMaker Pro Advanced, and across multiple platforms, but they can only be created and edited in FileMaker Pro Advanced.
- Newly defined functions appear under their own category in the functions list of the Specify Calculation and Define Custom Functions dialog boxes.

- If you do not wish to reveal your custom functions, you can disable the display of them in these dialog boxes.
- If you do not have full access privileges and attempt to edit a scripting or field calculation that uses a custom function that is restricted to full access accounts, you will see the string <Private Function> instead of the custom function. You cannot change the calculation when <Private Function> appears in the formula.

Creating custom functions

You must have Full Access privileges to the currently active database to use the Custom Functions feature.

To create a custom function:
1. Choose File menu > Define > Custom Functions.
2. In the Define Custom Functions dialog box, click New.
3. In the Edit Custom Function dialog box, for Function Name, type a name.

Custom function names have the following qualifications:

- Names must be unique.
- Names cannot exceed 100 characters in length.
- Names can contain spaces, but you should use underscores instead.

4. Build a formula.

For more information about building formulas, see Help.

5. If the formula requires parameters, type the parameter name in Function Parameters and click the Plus button.

You can edit or delete a parameter name by selecting it in the list and clicking the Edit or Delete buttons.
6. Click where you want an item to appear in the formula box.

7. Perform one of the following actions.

<table>
<thead>
<tr>
<th>To add a</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference to a parameter</td>
<td>In the parameters list, double-click a parameter name.</td>
</tr>
<tr>
<td>Mathematical or text operator</td>
<td>In the keypad, click an operator.</td>
</tr>
<tr>
<td>Comparison or logical operator</td>
<td>For Operators, choose an operator from the list.</td>
</tr>
<tr>
<td>Constant value</td>
<td>Type the value.</td>
</tr>
<tr>
<td>Function</td>
<td>In the functions list, double-click a function. In the formula box, replace the example parameter with a value or expression.</td>
</tr>
</tbody>
</table>

You can also type parameter names, operators, and functions in the Edit Custom Function dialog box instead of using the lists or keypad.

8. All accounts is the default option for Availability and allows all users of the current database to see and use the custom function.

9. If you want the custom function to be available only to those with full access privileges, select Only accounts assigned full access privileges.

10. Click OK.

**Editing custom functions**

The changes you make to a custom function are applied to that function wherever it is used.

To edit a custom function:

1. Choose File menu > Define > Custom Functions.
2. In the list of custom functions, select the function to be edited then click Edit.
3. In the Edit Custom Function dialog box, make the needed changes, then click OK.
To change the way functions are sorted in the Define Custom Functions dialog box, choose a category from the View list.

Deleting custom functions

When you delete a custom function, it is no longer available for use. If you have full access privileges to a database and are editing a calculation that uses a custom function that has been deleted, the name of the function is replaced with the string <Function Missing>.

To delete a custom function:
1. Choose File menu > Define > Custom Functions.
2. In the list of custom functions, select the function to be deleted and click Delete.
3. Continue working with custom functions or click OK.

Duplicating custom functions

You can make a copy of a custom function and then edit the copy to perform a similar operation.

To duplicate a custom function:
1. Choose File menu > Define > Custom Functions.
2. In the list of custom functions, select the function to be duplicated and click Duplicate.

The copy of the function appears in the list of custom functions with “Copy” appended to its name.
3. Continue working with custom functions or click OK.

About Kiosk mode

Kiosk mode is a way of displaying your database solution or your runtime database solution on a full screen, without any toolbars or menus. As the name suggests, Kiosk mode can be used to present your database to users as an information kiosk. You can design your database to run through a touch screen.

Database files that open in FileMaker Pro, FileMaker Pro Advanced, or the runtime application can be transformed into files that must open in Kiosk mode for all accounts with a specific privilege set. When you create a solution to run in Kiosk mode, you need to provide navigation for your solution and the ability for users to quit your solution. For more information about accounts and privileges, see Help.

Navigating in Kiosk mode

The primary file is the main database that users see first in your Kiosk solution. Because Kiosk mode does not contain any menus or window controls, the primary file must contain buttons that users can click to navigate through the solution, close the files, and to quit FileMaker Pro, FileMaker Pro Advanced, or the runtime application.

To decide how users will navigate your Kiosk solution, start by planning your navigation design on paper. Decide what will happen when each button is clicked, and give users a way to get back to the beginning of your solution from each layout. To further control what users see, create startup scripts that display a specific layout when a file is opened.

- If your Kiosk solution will be run with a touch screen, use large buttons and allow space between buttons.
- Try to limit the number of options available on one screen.
- Because Preview mode disables buttons, make sure that any Enter Preview Mode script step is followed by a Pause/Resume Script script step and specify an amount of time the script should remain in Preview mode. Place an Enter Browse Mode script step after the Pause/Resume Script script step.

Note When a Kiosk solution is open, access to the operating system is limited. On Windows machines, you can press Alt+Tab to go to another application from your Kiosk database solution.
**Closing Kiosk solutions**

If there is no Quit or Exit button available in your Kiosk solution, users must force-quit the application by pressing Alt+F4 (Windows). Mac OS X version 10.3 (v10.3) users can exit a solution running in Kiosk mode by pressing F9 or F11 to access another open application window. With Mac OS X versions 10.3 and 10.4, users can access other applications by pressing Control-F2. Force quitting is not recommended because it can cause data corruption or damage open files.

To ensure that users can access the primary file and quit the application cleanly:

- In each auxiliary file, provide a startup script that opens the primary file.
- In each auxiliary file, place a “Main Menu” button that runs the startup script to open the primary file.
- In the primary file, include an Exit button.

For information about creating buttons and scripts that emulate missing menu options and window controls, see “Emulating menu commands and window controls” on page 18.

**Creating Kiosk solutions**

Kiosk mode is ignored if the solution is opened by accounts with the Full Access privilege set, a privilege set that allows management of extended privileges, or a privilege set that allows modification of layouts, value lists, and scripts.

For your solution to display in Kiosk mode, you must:

- create an account with a limited privilege set or create a specific Kiosk account.
- enable Kiosk mode. At the same time that you enable Kiosk mode, you can bind the database as a runtime solution.
- clear the default option of logging into the file with the Admin account.

To create a Kiosk account:

1. Ensure you have a limited access account
2. With the database solution open, choose File menu > Define > Accounts & Privileges.
3. In the Define Accounts & Privileges dialog box, click New.
4. In the Edit Account dialog box, type an account name, click Active for the Account Status, and select New Privilege Set from the Privilege Set list.
5. In the Edit Privilege Set dialog box, give the privilege set a name and description.
6. For Layouts, Value Lists, and Scripts, select either All view only or All no access.
7. Clear the Manage extended privileges checkbox.
8. Select other options as required.
9. Click OK.

To enable Kiosk mode:

1. Follow steps 1 to 9 in “Modifying database solution files” on page 64.
2. In the Specify Solution Options dialog box, select Enable Kiosk mode for non-admin accounts.
3. Select other options as required.
4. Click OK.
5. To be able to quickly repeat the process, click Save Settings, and choose a folder and location for your settings file.

See “Saving and reusing Developer Utilities settings” on page 71.
6. Click Create.

If you did not bind the files to a runtime application, the Developer Utilities copy the selected database files to the Project Folder. If you did bind the files to a runtime application, the Developer Utilities copy all of the runtime files to a new folder created inside the Project Folder and named after the runtime solution.

To change the default option of logging into the file with the Admin account:

1. With the database solution open, choose File menu > File Options.
2. On the Open/Close tab, clear Log in using.
3. Click OK.

**Using scripts and buttons to control your solution**

You can use scripts and buttons to automate much of your database solution, control startup behavior, emulate menu commands and window controls, navigate, and much more. For more information about creating scripts to automate tasks, see Help.

**Tip** Use the Script Debugger to test scripts. See “Stepping through scripts” on page 55.

**Centering database windows in Kiosk screens**

If you maximize a layout that was designed for 640x480 on a screen that has a resolution larger than 640x480, the layout will not be centered. It will display in the top left corner with empty space surrounding it. For best results, don’t maximize kiosk windows. Use the Adjust Window[Resize to Fit] and Move/Resize Window script steps instead to center windows based on the user’s screen resolution. Use the Get functions to determine the resolution.

**Important** Before using the Adjust Window script step, perform any script steps that affect the window display area (such as Go to Layout or Show/Hide Status Area). Once the window area is determined, add the Adjust Window script step.

The Adjust Window script step may cover up a window that has an Exit Application button. Be sure that users can close the Kiosk database solution easily.

**Emulating menu commands and window controls**

Use the following script steps to emulate menu commands and window controls.

<table>
<thead>
<tr>
<th>To emulate these interface elements</th>
<th>Create buttons with these script steps attached</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu commands</td>
<td>Script steps for any menu command (for example, Sort Records, Print, and Open Preferences)</td>
</tr>
<tr>
<td>Zoom controls</td>
<td>Adjust Window or Set Zoom Level</td>
</tr>
<tr>
<td>Status area control</td>
<td>Show/Hide Status Area</td>
</tr>
<tr>
<td>Mode pop-up menu</td>
<td>Enter Browse Mode, Enter Find Mode, or Enter Preview Mode</td>
</tr>
<tr>
<td>Vertical scroll bar</td>
<td>Scroll Window (if the layout is longer than one screen)</td>
</tr>
<tr>
<td>Horizontal scroll bar</td>
<td>Scroll Window (if the layout objects are wider than one screen)</td>
</tr>
<tr>
<td>Window size and location</td>
<td>Move/Resize Window</td>
</tr>
</tbody>
</table>

**Creating dynamic buttons**

By using scripts and calculations to evaluate the state of button fields, you can make dynamic buttons that change each time they are clicked.

To create dynamic buttons:

1. Define the dynamic button field.
2. Create the dynamic button script.
3. Connect the field and the script.

The following example shows how to create a button that changes every time it is clicked.
To define the dynamic button field:
1. Choose File menu > Define > Database > Fields tab.
2. Create a field named Icons and make it a Container type.
3. Click Options > Storage tab.
4. Select the Use global storage checkbox and type the number of button states for the Maximum number of repetitions.
5. Click OK.
6. In Browse mode, select the Icons field and choose Insert menu > Picture to add graphics to the Icons field.

   Tip Ensure that all graphics are the same size.

7. Choose File menu > Define > Database > Fields tab.
8. Create a container field named Buttons.
9. Click Options > Auto-Enter tab.
10. For Calculated value, click Specify and enter the function
    \[
    \text{GetRepetition (Icons; 1)}
    \]
11. Click OK.

To create the dynamic button script:
2. Name the script Toggle Buttons.
3. Add a Set Field script step.
4. For Specify target field, click Specify.
5. Double-click Buttons.
6. For Calculated result, click Specify.
7. Write a Case function that evaluates each GetRepetition test expression for the icon number and increments the number by one.

   Case
   
   GetRepetition (Icons; 1); GetRepetition (Icons; 2);
   GetRepetition (Icons; 3);
   GetRepetition (Icons; 4);
   GetRepetition (Icons; 5);
   GetRepetition (Icons; 1)
   
   Case function for dynamic buttons

8. Click OK.

To connect the field and the script:
1. Choose View menu > Layout Mode.
2. Select the Buttons field and choose Format menu > Field/Control > Behavior.
3. Clear both Allow field to be entered checkboxes and click OK.
5. Select Perform Script and specify Toggle Buttons.
6. Click OK.

You can switch to Browse mode and test your dynamic button. For more information about using buttons with scripts, see Help.
Chapter 3
Customizing menus

With FileMaker Pro Advanced, you can create custom menus for your database solutions. You can add, edit, duplicate, or delete menus and menu items in many ways, such as:

- Changing a menu item name.
- Performing a script or script step from a menu item. You can also run scripts from an associated toolbar icon and shortcut menu.
- Assigning custom keyboard shortcuts and access keys.
- Specifying a platform for your menus and menu items.
- Specifying a mode for your menus.
- Specifying menu sets for files and layouts.

About customizing menus

You can customize menus by:

- editing a copy of a standard FileMaker menu. Use this method to make minor changes to existing menus, for example, to modify the properties of a few menu items. See “Customizing menus” on page 23.

- starting with an empty menu. Use this method to make significant changes to menus, for example, to add menus and change menu item properties.

You may need to modify menu sets and specify when FileMaker installs them. See “Customizing menu sets” on page 27 and “Installing menu sets” on page 29.

The following example shows how to customize the New Record menu item that appears in the Records menu. You can rename the New Record menu item to New Invoice, then attach a script that runs when the user chooses the New Invoice menu item. Finally, you can change the default menu set so your new custom menu set displays when a user opens the database.

This example assumes the database contains a script called My New Invoice. My New Invoice automates several tasks, like switching to the Invoices layout and creating an empty record. See Help for information about creating scripts.

1. Open the database and choose File menu > Define > Custom Menus. Double-click the Records Copy menu to edit a copy of the standard Records menu. See “Creating and editing custom menus” on page 23.

2. Select the New Record menu item to modify the properties of the menu item. Change the title of the New Record menu item to New Invoice. See “Creating and editing menu items” on page 24.

3. Change the action of the menu item to run the My New Invoice script. See “Creating and editing menu items” on page 24.

4. Set the default menu set for the file to Custom Menu Set #1. See “Specifying a default menu set” on page 29.

5. Click OK.
How custom menus affect other features

Custom menus can impact other product features. Keep these points in mind:

- Custom menus display in FileMaker Pro and runtime solutions but cannot be edited.
- Web published databases do not recognize customized menu commands. For example, if you customize the New Record command to quit the application, this will have no effect in Instant Web Publishing; web users will see the default New Record command.
- FileMaker features only work if they are included in a menu. For example, if you remove the View menu from the menu set and do not have any scripted buttons on the layout to switch views, the mode buttons in the status area are disabled, making it impossible for your users to switch modes.
- If the Edit menu is not part of an installed menu set, the Cut, Copy, and Paste shortcuts do not work.
- It is important to provide user documentation with your solution because the custom menus won’t match the product documentation.
- Standard FileMaker menus and menu items are localized based on the operating system’s language. However, if you customize the title of a menu or menu item, it will not be localized when the system’s language is changed.
- Standard FileMaker menu items are dimmed if users don’t have privileges to perform the menu command. Menus are not dimmed if you attach a script to the menu item.
- The Open Help script step displays FileMaker Pro help, not customized help.

Custom menu terminology

Before you begin working with custom menus, you should understand the following terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu bar</td>
<td>The area at the top of the screen (Mac OS) or window (Windows) that displays the installed menu set.</td>
</tr>
<tr>
<td>Menu set</td>
<td>The collection of menus that installs on the menu bar.</td>
</tr>
<tr>
<td>Menu</td>
<td>A list of menu items. Each menu has a title that appears on the menu bar. Menus display according to the specified platform and mode settings.</td>
</tr>
<tr>
<td>Menu item</td>
<td>One item listed in a menu on the menu bar. A menu item can perform an action or be a submenu or a separator. Menu items display according to the specified platform settings.</td>
</tr>
<tr>
<td>Menu item properties</td>
<td>All the settings for a menu item, including platform, display title, shortcut, and action.</td>
</tr>
<tr>
<td>Submenu</td>
<td>A menu that extends from another menu item.</td>
</tr>
<tr>
<td>Shortcut</td>
<td>Also known as keyboard shortcut. Indicates the keystroke combination that can be used instead of choosing the command’s menu item.</td>
</tr>
<tr>
<td>Access key (Windows)</td>
<td>Users can select a menu or menu item by pressing the Alt key with the designated access key.</td>
</tr>
<tr>
<td>Action</td>
<td>Overrides the menu item’s action to perform a specified script or script step.</td>
</tr>
<tr>
<td>Command</td>
<td>Specifies which task to perform; for example, deleting a record.</td>
</tr>
<tr>
<td>Display title</td>
<td>The text or name that appears on the menu bar or menu to identify a menu or menu item.</td>
</tr>
<tr>
<td>Separator</td>
<td>A line within the menu to separate or group items in the list.</td>
</tr>
<tr>
<td>Standard FileMaker Menus</td>
<td>A menu set containing all the non-customized, default FileMaker menus.</td>
</tr>
</tbody>
</table>
Customizing menus

You can use FileMaker Pro Advanced to create custom menus. You can:

- Create a menu or edit an existing menu
- Duplicate or delete a menu
- Add, duplicate, or delete menu items
- Specify menu item properties, such as display title, shortcut, and action.

Note You must have full access privileges to customize menus.

Creating and editing custom menus

You can create a menu by starting with a blank menu or by editing a copy of a standard FileMaker menu.

You can duplicate a menu so you can make changes without modifying the original or delete menus that your users will not need.

To duplicate or delete a menu:
1. Choose File menu > Define > Custom Menus > Custom Menus tab.
2. Do one of the following in the Define Custom Menus dialog box then click OK:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate a menu</td>
<td>Select the menu from the list, then click Duplicate.</td>
</tr>
<tr>
<td>Delete a menu</td>
<td>Select the menu from the list, then click Delete. Important When you delete a menu, you also delete its menu items.</td>
</tr>
</tbody>
</table>

To create or edit a menu:
1. Choose File menu > Define > Custom Menus > Custom Menus tab.
2. Do one of the following in the Define Custom Menus dialog box:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a menu</td>
<td>Click Create.</td>
</tr>
<tr>
<td></td>
<td>In the Create Custom Menu dialog box, do one of the following, then click OK:</td>
</tr>
<tr>
<td></td>
<td>- Click Start with an empty menu</td>
</tr>
<tr>
<td></td>
<td>- Click Start with a standard FileMaker menu, then select a menu from the list.</td>
</tr>
<tr>
<td>Note</td>
<td>You can press Shift and click Create to create an empty menu.</td>
</tr>
</tbody>
</table>

3. In the Edit Custom Menu dialog box, specify the options for the custom menu.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the menu name</td>
<td>For Custom Menu Name, enter a descriptive name for the menu (up to 100 characters). This name appears in the Custom Menu list of the Define Custom Menus dialog box. It does not appear in the menu or menu bar.</td>
</tr>
<tr>
<td>Specify the title that you want to display in the menu bar</td>
<td>For Default Display Title, select Override Title, then enter the name (up to 30,000 characters). To specify an access key (Windows), type an ampersand (&amp;) before the character you want to use as the access key. For example, type &amp;File to display the File menu with the letter “F” as the access key.</td>
</tr>
<tr>
<td></td>
<td>To base the menu title on the result of a calculation, click Specify, then build a formula in the Specify Calculation dialog box.</td>
</tr>
<tr>
<td>Include a comment in the Define Custom Menus dialog box</td>
<td>Enter a comment about the menu (up to 30,000 characters).</td>
</tr>
</tbody>
</table>

4. To add or edit menu items in the menu, continue with Step 3 in the next section, “Creating and editing menu items.”

**Creating and editing menu items**

After you create a menu, you can create menu items. You can also create or edit menu items that are copies of the Standard FileMaker menus. Menu items can be commands, submenus or separators. You can create a menu item that is based on a standard FileMaker command or you can create a menu item that initially does not have an assigned command.

When you base a menu item on a FileMaker command, that menu item inherits all the properties of that command. You can override properties (title, shortcut, or action) to customize the menu item.
When you create a menu item that does not have an assigned command, an untitled menu item appears in the Menu Items list of the Edit Custom Menu dialog box. You can then customize the menu item properties.

1. Choose File menu > Define > Custom Menus > Custom Menus tab.

2. In the Define Custom Menus dialog box, select the menu from the list, then click Edit.

3. In the Edit Custom Menu dialog box, specify which menu items are included in the menu:

<table>
<thead>
<tr>
<th>To Do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a command</td>
<td>Click Command. In the Specify FileMaker Command dialog box, do one of the following, then click OK.</td>
</tr>
<tr>
<td></td>
<td>■ Click No command assigned. FileMaker Pro Advanced adds an Untitled menu item to the Menu Item list. You must specify properties for this command (see Step 4).</td>
</tr>
<tr>
<td></td>
<td>■ Click Use a FileMaker command, then select a command from the list. The command determines the action or behavior of the menu item.</td>
</tr>
<tr>
<td></td>
<td>Tip You can press Shift and click Command to create an Untitled command menu item.</td>
</tr>
<tr>
<td>Add a submenu</td>
<td>Click Submenu to add another menu’s commands to the current menu. In the Specify Submenu dialog box, select the menu you want to include, then click OK. Note You can add up to 100 menus to the menu bar. If you add a menu that includes itself as a submenu, you may quickly reach the limit.</td>
</tr>
<tr>
<td>Add a separator line</td>
<td>Select the menu item from the list under which you want the separator line to appear, then click Separator.</td>
</tr>
<tr>
<td>Duplicate a menu item</td>
<td>Select a menu item from the list, then click .</td>
</tr>
<tr>
<td>Delete a menu item</td>
<td>Select a menu item from the list, then click .</td>
</tr>
</tbody>
</table>

4. Select each menu item from the Menu Items list and specify its properties.

<table>
<thead>
<tr>
<th>To Do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change a command for a menu item</td>
<td>Click Specify. In the Specify FileMaker Command dialog box, select a command, then click OK.</td>
</tr>
<tr>
<td>Choose a platform for a menu item</td>
<td>Select Windows, Macintosh, or both. Your menu item will appear on the platforms you select. Note Some commands are valid on only one platform.</td>
</tr>
<tr>
<td>Change the title for a menu item</td>
<td>Select Title and enter the text. To specify an access key (Windows), type an ampersand (&amp;) before the character you want to use as the access key. For example, type &amp;Open to display the Open menu item with the letter “O” as the access key. To base the menu title on the result of a calculation, click Specify, then build a formula in the Specify Calculation dialog box. Note Untitled menu items do not have a checkbox.</td>
</tr>
</tbody>
</table>
Keep these points in mind:

- To override a command’s behavior (title, shortcut, or action), you must select its checkbox. If the checkbox is not selected, the original command behavior is retained.
- Icons on the toolbar are linked to menu items. If you customize a menu item that has a toolbar icon, you also customize the icon. For example, the New Record icon is linked to the New Record menu item. If you customize the New Record menu item by renaming it to New Contact and specify a script be performed, the toolbar icon will perform the custom New Contact script and the tooltip for the icon will display New Contact. The Usage area of the Edit Custom Menu dialog box indicates that you are customizing a menu item that is linked to a toolbar icon.
- Shortcut menus display when a user right-clicks (Windows) or Control-clicks (Mac OS) an object or an area. If you customize a menu item that has a shortcut menu item, you also customize the behavior performed by the shortcut menu item.
- FileMaker Pro Advanced updates menus and menu items when a menu set change is requested either through switching modes, windows, or layouts, or by performing a script that accomplishes a similar result. Menu and menu item titles based on field contents or functions only update when menu sets change.
- If you enter the same shortcut or access keys for two menu items, FileMaker will recognize the first occurrence in the menu bar (from right to left, top to bottom).
- If you want an ampersand to appear as part of a menu or menu item title, you must type the ampersand twice. For example, if you want a menu title to appear as Records & Reports, enter the title as Records && Reports.
You can modify privilege sets in the Edit Privileges dialog box to control which menu items are enabled.

- If you set Available menu commands to Editing only or Minimum, menu items based on FileMaker commands are enabled or disabled according to the setting. All other menu items, including items with customized actions, are disabled. For example, if you choose Editing only, all basic FileMaker editing commands are enabled but all other items (including items with customized actions) are disabled.

- If you set Available menu commands to All, all menu items are enabled normally. For information about access privileges, see Help.

FileMaker uses shortcuts that don’t appear in the menu bar. For example, Command-Option-Z zooms a Mac OS window. In addition, the operating system defines shortcuts. Both types of shortcuts override the ones you define in the Specify Shortcuts dialog box.

- Windows and Mac OS shortcuts are different. For example, if you use FileMaker Pro Advanced for Windows to define the Ctrl+H shortcut, then open the file in Mac OS, the shortcut maps to Command-H. This conflicts with the Mac OS shortcut to hide an open application. The shortcut works as expected on Windows, but on Mac OS, the operating system shortcut overrides the custom-defined shortcut.

- Be sure to test custom shortcuts on both platforms. For information about shortcuts, see the documentation provided with your operating system.

- Mac OS: You can assign keyboard shortcuts for applications using the Mac OS X Keyboard & Mouse system preference. If you define a keyboard shortcut for a FileMaker Pro menu in the system preferences, it becomes the default shortcut for the menu command in Custom Menus, including the Standard FileMaker Menus menu set. This menu item will always be present in the menu, and users won’t be able to change the shortcut by making changes in the custom menu dialog boxes.

**Customizing menu sets**

You can create custom menu sets to include the menus you require. You can then specify a menu set for the file and for individual layouts. Keep the following points in mind:

- Mac OS: If you do not include a Help menu in your menu set, the operating system will install an empty Help menu. You cannot remove this menu, change its position on the menu bar, or change its title.

- Mac OS: The FileMaker Pro menu is added after the Apple menu. You cannot customize the Quit or Preferences menu items. You can only customize the About FileMaker Pro and Sharing menu items.

- Windows: The Exit menu item is added at the end of the first unlocked (modifiable) menu. You cannot customize the Exit menu item.

**Creating and editing menu sets**

You can create a new menu set or edit or duplicate an existing one. You can also delete menu sets that your users will not need.

**Important** Duplicating a custom menu set creates a copy of the menu set and references the same custom menus as the original menu set. It does not duplicate the custom menus. If you change a menu item, you change the menu for all menu sets in which the menu is included.
To create or edit menu sets:

1. Choose File menu > Define > Custom Menus > Menu Sets tab.

2. Choose File menu > Define > Custom Menus > Menu Sets tab.

2. Do one of the following in the Define Custom Menus dialog box:

To | Do this
--- | ---
Create a menu set | Click Create.
Edit an existing menu set | Select the menu set from the list, then click Edit.

3. In the Edit Menu Set dialog box, do the following:

To | Do this
--- | ---
Specify the menu set name | For Menu Set Name, enter a descriptive name for the menu set (up to 100 characters). This name appears in the list on the Menu Sets tab in the Define Custom Menus dialog box.
Include a comment in the Define Custom Menus dialog box (Menu Sets tab) | Enter a comment about the menu set (up to 30,000 characters).

4. Specify which menus you want to include in the menu set, and click OK.

To | Do this
--- | ---
Add a menu to the menu set | Select the menu from the list of Available Custom Menus, then click Move.
| Double-click the menu in the list of Available Custom Menus.
Remove a menu from the menu set | Select the menu you want to remove from the menu set, then click Clear.
Create a menu | Click Create, then follow the procedure for “Creating and editing custom menus” on page 23.

Note You can press Shift and click Create to create an empty menu.
### Tocustomizing menusto

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate a menu</td>
<td>Select the menu from the list, then click Duplicate.</td>
</tr>
<tr>
<td>Edit a menu</td>
<td>Select the menu, then click Edit. In the Edit Custom Menu dialog box, edit the menu, then click OK. See “Creating and editing custom menus” on page 23.</td>
</tr>
</tbody>
</table>

To duplicate or delete a menu set:
1. Choose File menu > Define > Custom Menus > Menu Sets tab.
2. Do one of the following in the Define Custom Menus dialog box, then click OK.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate a menu set</td>
<td>Select the menu set from the list, then click Duplicate.</td>
</tr>
<tr>
<td>Delete a menu set</td>
<td>Select the menu set from the list, then click Delete.</td>
</tr>
</tbody>
</table>

### Installing menus

Once you create menu sets, you must specify options for installing them. You can:
- Specify a default menu set for a file
- Specify menu sets for individual layouts
- Create scripts that change menu sets
- Specify menus within the menu set to display according to mode. For more information, see “Creating and editing custom menus” on page 23.
- Switch menu sets using the FileMaker Pro Advanced Tools menu

### Specifying menu sets for individual layouts

You can specify different menu sets for individual layouts.
1. In Layout mode, choose Layouts menu > Layout Setup > General tab.
2. For Menu Set, select a menu set, then click OK.

### Specifying a default menu set

You can specify a default menu set for all layouts in a file.
1. Choose File menu > Define > Custom Menus.
2. For Default menu set for this file, choose a menu set.

---

*Chapter 3 | Customizing menus*
Keep these points in mind:

- If you choose a menu set other than [File Default], that menu set overrides the selection in the Define Custom Menus dialog box when the layout displays.
- In Layout mode, select Layouts menu > Set Layout Order to display the Set Layout Order dialog box and review the menu set assigned to each layout.

Creating scripts to change menu sets

You can create scripts that change menu sets based on conditions that you specify. For information about scripts or the Install Menu Set script step, see Help.

You can use Get (CustomMenuSetName) to check for the name of the active custom menu set. You can also use the Get(LastError) function to check for missing menu sets. Check the status of the Get(LastError) function after performing the Install Menu Set script step. If a menu set is missing, the function will return error 115. For more information, see Help.

Testing menu sets

Before distributing a database with custom menus, test all menus and menu items on both platforms for each user account. Be sure that all the necessary menus and menu items are available so that users can perform their tasks. Be sure users can always access the View menu, or provide a method (like buttons) to switch between Browse, Find, and Preview modes.

You can also review the Database Design Report to check for any shortcut or access key conflicts.

In FileMaker Pro Advanced, you can temporarily switch menu sets or restore standard FileMaker menus using the Tools menu, which is always added to the menu bar:

1. Choose Tools menu > Custom Menus.
2. Select the menu set you want.

When using FileMaker Pro or FileMaker Pro Advanced, you can check to see if custom menus are installed:

- Windows: Choose Help menu > About FileMaker Pro, then click Info.
- Mac OS: Choose FileMaker Pro menu > About FileMaker Pro, then click Info.

When custom menus are installed, the dialog displays Custom Menus Active.

Using customized About, Help, or Script menus from previous versions

Previous versions of FileMaker Developer allowed users to customize the Help, About, and Script menus for runtime solutions. These were the only menus that could be modified.

If you use FileMaker Pro Advanced to open a runtime file created in FileMaker Developer, any customized About, Help, and Script menus will appear as part of the Standard FileMaker Menus menu set. You cannot change them. Custom Menu Set #1 provides a copy of the FileMaker Pro Advanced standard menus.
Chapter 4
Creating custom layout themes

FileMaker Pro and FileMaker Pro Advanced use a variety of layout themes to describe the colors, patterns, fonts, and borders of text, fields, and parts in a new layout.

A theme is an Extensible Markup Language (XML) document that can be read and edited in a text editor (such as Notepad for Windows or BBEdit for Mac OS X) or XML editor (such as XML SPY or XMetaL). You can customize an existing theme or create your own, and then use the New Layout/Report assistant to apply the custom theme when you create layouts for your databases. You can modify attributes defined by the theme in Layout mode after the layout is created. However, you can’t apply a theme to an existing layout.

Note A FileMaker theme is not a stylesheet and does not contain positioning information for objects on a layout.

For information about:
- using layout themes and designing layouts, see Help
- XML and its uses, see www.filemaker.com/xml
- publishing your database on the web in XML format, see the PDF manual, FileMaker Instant Web Publishing Guide

Modifying FileMaker Pro Advanced themes

FileMaker Pro and FileMaker Pro Advanced include theme files that can be modified. A theme file can contain more than one theme. For example, the Blue_gold.fth file contains two themes: “Blue and Gold Screen” (for viewing onscreen) and “Blue and Gold Print” (for printing).

Create themes to automatically apply different styles to text and background fills in layout parts, fields, and field labels.
Important The XML for a layout theme must be well-formed and comply with the required syntax. See “Requirements for theme files” on page 33 and “Checking theme files for errors” on page 41.

To modify a theme:

1. Make a copy of one of the theme files in the Themes folder.
   Windows: FileMaker Pro 8 Advanced\Extensions\English\Themes\ or
   Mac OS X: FileMaker Pro 8 Advanced/ FileMaker Pro 8 Advanced.app/Contents/Resources/English.lproj/Themes/

Important The total number of theme files is limited to 50.

2. Rename the copy and include the .fth extension with the new filename.
   Keep the new file in the Themes folder. In order for the New Layout/Report assistant to display a theme option, the theme file must reside in the Themes folder and it must have the .fth filename extension.

3. Open the theme file in a text editor.

   4. Change the name of a theme by replacing the value of the THEMENAME element with a new name.

   <THEMENAME VALUE="Purple and White Screen" />

   Note If your THEMENAME value contains any upper-ASCII characters, use the HINT attribute to ensure that the theme name will appear on both the Windows and Mac OS X platforms. For information, see “Valid values for theme attributes” on page 37.

5. Change the values of other elements and attributes.
   For example, to change the background fill color of the body part in a layout to a light purple, change the color hexadecimal (hex) value to #9933CC:

   <BODYPART>
     <FILL COLOR = "#9933CC" PATTERN = "2" />
   </BODYPART>

   For guidelines, see the table in “Valid values for theme attributes” on page 37 and “Using values for patterns and colors” on page 40.

6. Remove any elements that you don’t want to specify.
   Be sure to remove the entire single-line or multi-line element including its start and end tags. For information, see “Removing elements from theme files” on page 34.

7. Scroll down to the next FMTHEME element and repeat these steps to change the THEMENAME value and other elements.

8. Save the file in text format with the filename extension .fth in the Themes folder inside the FileMaker Pro 8 Advanced folder.

Each new THEMENAME value will appear in the New Layout/Report assistant as a Layout Theme option.

Follow the instruction in the New Layout/Report assistant. The third panel presents you with a list of themes to select from.

![Image of New Layout/Report assistant](image)

Names of custom themes appear as options in the New Layout/Report assistant

If your new themes don’t appear in the New Layout/Report assistant, you might have made a syntax error. For information, see “Checking theme files for errors” on page 41.

### Requirements for theme files

FileMaker Pro Advanced layout themes are described in an XML document saved in text file format. Each text file must have the .fth filename extension and reside in the Themes folder inside the FileMaker Pro Advanced application folder.

XML resembles HTML in many ways. However, unlike HTML, the XML for layout themes must be well-formed and comply with the required syntax. Omitting a required element or attribute, or mismatching start and end tags will result in an unusable document and FileMaker Pro Advanced will be unable to parse the XML or display the theme in the New Layout/Report assistant.

#### Minimum XML elements for themes

Every theme file must begin with an XML-document processing instruction that declares it as an XML document using the XML 1.0 specification. In addition, an XML document for a layout theme must contain the `<FMTHEMES>` and `</FMTHEMES>` start and end tags for the file. This FMTHEMES root element can contain one or more FMTHEME element.

![Minimum elements required for a theme file](image)

Containing all of your themes (FMTHEME elements) in one file is useful if you want to organize the way that themes appear in the New Report/Layout assistant. The order that FMTHEME elements are listed in the file determines the order in which the THEMENAME values appear.

**Note** Values for the THEMENAME element can contain any characters from the ASCII character set. However, if you’re using an XML editor to write your themes or if you plan to use the themes on different platforms, certain measures must be taken.
XML editors expect these characters to be coded as character entities:

<table>
<thead>
<tr>
<th>Character</th>
<th>Coded as</th>
</tr>
</thead>
<tbody>
<tr>
<td>ampersand (&amp;)</td>
<td>&amp;</td>
</tr>
<tr>
<td>less than (&lt;)</td>
<td>&lt;</td>
</tr>
<tr>
<td>greater than (&gt;)</td>
<td>&gt;</td>
</tr>
<tr>
<td>apostrophe (‘)</td>
<td>'</td>
</tr>
<tr>
<td>quote (&quot;)</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

Using the character instead of the character entity results in an error from the XML editor. However, FileMaker Pro and FileMaker Pro Advanced do not reinterpret character entities. Values in the THEMENAME element will appear exactly as typed. You can avoid the problem by using a text editor to create your themes or by ignoring the error from the XML editor. Your theme names will appear as you write them in the New Layout/Report assistant.

If you’re planning to use your themes on Windows and Mac OS X platforms, use the HINT attribute to ensure that upper-ASCII characters (such as the accent mark) appear correctly on both platforms. For more information, see “Valid values for theme attributes” on page 37.

**Removing elements from theme files**

Theme files contain multi-line elements for fields, field labels, text, and every part in a layout. Each of these elements contains other multi-line elements and single-line elements. You can remove any of these elements, but you must remove the entire element, which includes everything inside the element’s start and end tags and the start and end tags as well.

FileMaker Pro Advanced will use default values for any elements you remove. See “Specifying default values for themes” on page 40.

A single-line element, such as the PEN element, begins with `<PEN` and ends with `/>` on a single line:

```
<PEN COLOR="#000066" PATTERN="2" SIZE="0" />
```

A multi-line element has start and end tags on separate lines:

```
<BORDER>
</BORDER>
```

To remove a multi-line element, delete the start and end tags and all elements contained within them. For example, to remove a multi-line BORDER element in the Blue_gold.fth file, delete all three lines:

```
<BORDER>
<PEN COLOR="#000000" PATTERN="2" SIZE="1" />
</BORDER>
```

**XML elements for layout parts**

An FMTHEME element can contain any of the following multi-line elements to describe the parts in a layout. Each layout part element contains additional elements to describe the background fill, text, field labels, and fields in the layout part.

Elements for layout parts can be listed in any order within an FMTHEME element in the XML document. However, if two identical elements are listed (such as two BODYPART elements), FileMaker Pro Advanced will only use the attributes for the last one in the list.

<table>
<thead>
<tr>
<th>This multi-lined element is used</th>
<th>To describe this layout part</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;TITLEHEADERPART&gt;</code></td>
<td>Title header — appears only once at the top of the first screen or page.</td>
</tr>
<tr>
<td><code>&lt;/TITLEHEADERPART&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;HEADERPART&gt;</code></td>
<td>Header — appears at the top of every screen or page, except the first one if there’s a title header.</td>
</tr>
<tr>
<td><code>&lt;/HEADERPART&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
### Creating custom layout themes

Although a theme may include descriptions for every type of layout part, the type of layout you select in the New Layout/Report assistant determines which parts will appear in your new layout or report.

For information about layout parts, see Help.

### XML elements for text

Any layout part element can contain FIELD, TEXTLABEL, and TEXT elements that are used to describe the characteristics of text or data in the part.

The FIELD element is used to describe text (data) in fields and field borders. The TEXTLABEL element is used for field label text. Field labels are displayed in the body part of a layout or in other parts such as the header of columnar reports. The TEXT element describes all other text that appears in a layout part, such as title text in the header.

### XML elements and their theme attributes

The following tables describe the multi-line and single-line XML elements supported by FileMaker Pro Advanced in a layout theme document. Unknown elements are ignored by FileMaker Pro Advanced.

#### Table of multi-line elements

<table>
<thead>
<tr>
<th>This multi-lined element is used</th>
<th>To describe this layout part</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;LEADGRANDSUMPART&gt;</code></td>
<td>Leading grand summary — appears at the beginning of a report and displays a summary field for all the records in a found set. A layout can have only one leading grand summary part.</td>
</tr>
<tr>
<td><code>/LEADGRANDSUMPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;LEADSUBSUMPART&gt;</code></td>
<td>Leading subsummary — appears above the body part and displays a summary field for a subset of records as defined by the break field. You can describe up to nine leading subsummary layout parts. Each LEADSUBSUMPART element must contain a PARTNUMBER element to distinguish it from the others.</td>
</tr>
<tr>
<td><code>/LEADSUBSUMPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;BODYPART&gt;</code></td>
<td>Body — appears in the middle of every screen or page. A layout can have only one body part.</td>
</tr>
<tr>
<td><code>/BODYPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;TRAILSUBSUMPART&gt;</code></td>
<td>Trailing subsummary — appears below the body part and displays a summary field for a subset of records as defined by the break field. You can describe up to nine trailing subsummary layout parts. Each TRAILSUBSUMPART element must contain a PARTNUMBER element to distinguish it from the others.</td>
</tr>
<tr>
<td><code>/TRAILSUBSUMPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;TRAILGRANDSUMPART&gt;</code></td>
<td>Trailing grand summary — appears at the end of a report and displays a summary field for all the records in a found set. A layout can have only one trailing grand summary part.</td>
</tr>
<tr>
<td><code>/TRAILGRANDSUMPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;FOOTERPART&gt;</code></td>
<td>Footer — appears at the bottom of every screen or page, except the first one if there’s a title footer.</td>
</tr>
<tr>
<td><code>/FOOTERPART</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt;TITLEFOOTPART&gt;</code></td>
<td>Title footer — appears only once at the bottom of the first screen or page.</td>
</tr>
<tr>
<td><code>/TITLEFOOTPART</code></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>These multi-line elements</th>
<th>May contain these elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>FMTHEMES</td>
<td>FMTHEME</td>
</tr>
<tr>
<td>(required)</td>
<td>The FMTHEMES root element can contain multiple FMTHEME elements.</td>
</tr>
<tr>
<td>FMTHEME</td>
<td>VERSION</td>
</tr>
<tr>
<td>(required)</td>
<td>THEMENAME (required)</td>
</tr>
<tr>
<td></td>
<td>THEMEDEFAULT</td>
</tr>
<tr>
<td></td>
<td>Any or all layout part elements</td>
</tr>
</tbody>
</table>
BORDER and EFFECT elements share the same pen size. When used together, the pen size value that you set for BORDER will also apply to the EFFECT width. The pen size value must be greater than zero in order for an effect or a border to appear.

### Table of single-line elements

The following table describes the correct syntax for all single-line elements and their attributes. Examples of attribute values are indicated in boldface. For a list of the possible values you can use for these attributes, see the next section, “Valid values for theme attributes.”

<table>
<thead>
<tr>
<th>These single-line elements</th>
<th>Must contain these attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>TITLEHEADERPART</td>
<td></td>
</tr>
<tr>
<td>HEADERPART</td>
<td></td>
</tr>
<tr>
<td>LEADGRANDSUMPART</td>
<td></td>
</tr>
<tr>
<td>BODYPART</td>
<td></td>
</tr>
<tr>
<td>TRAILGRANDSUMPART</td>
<td></td>
</tr>
<tr>
<td>FOOTERPART</td>
<td></td>
</tr>
<tr>
<td>TITLEFOOTPART</td>
<td></td>
</tr>
<tr>
<td>LEADSUBSUMPART</td>
<td>FILL</td>
</tr>
<tr>
<td>TRAILSUBSUMPART</td>
<td>FILL</td>
</tr>
<tr>
<td>FIELD</td>
<td>BASELINE</td>
</tr>
<tr>
<td>TEXT</td>
<td>CHARSTYLE</td>
</tr>
<tr>
<td>TEXTLABEL</td>
<td>EFFECT</td>
</tr>
<tr>
<td></td>
<td>FILL</td>
</tr>
<tr>
<td>TEXT (text/data in a field)</td>
<td>( )</td>
</tr>
<tr>
<td>TEXT (text in a part, except field labels or field data)</td>
<td>CHARSTYLE</td>
</tr>
<tr>
<td>TEXTLABEL (text in a field label)</td>
<td>CHARSTYLE</td>
</tr>
<tr>
<td>BASELINE (underlining field data)</td>
<td>ONOFF</td>
</tr>
<tr>
<td>BORDER (field border)</td>
<td>PEN</td>
</tr>
</tbody>
</table>
Valid values for theme attributes

The following table describes the attribute values supported by FileMaker Pro Advanced in a layout theme. Values must be enclosed within quotation marks (" "). If a quotation mark is missing, FileMaker Pro Advanced is unable to parse the XML and cannot display the theme in the New Layout/Report assistant.

<table>
<thead>
<tr>
<th>This attribute</th>
<th>Is used to describe these characteristics</th>
<th>And may contain these values</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLOR</td>
<td>RGB color hex values for background fills, text, and borders in layout parts, fields, text blocks, and field labels.</td>
<td>COLOR = &quot;#FFFFFF&quot;</td>
</tr>
<tr>
<td></td>
<td>To display a color, the PATTERN attribute must not be set to “1” (which is transparent).</td>
<td>Or any 6-digit hex value (a combination of numbers 0-9 or letters A-F) preceded by the # symbol.</td>
</tr>
<tr>
<td>THEMENAME</td>
<td>Emossing, engraving, or drop shadow 3-D effects for a field, text, or field label.</td>
<td>VALUE = “EMBOSS”</td>
</tr>
<tr>
<td></td>
<td>When used in conjunction with a field border, the line width of the effect will be the same as the border pen size. The pen size value must be greater than zero in order for the effect or border to appear.</td>
<td>For more information, see “Specifying default values for themes” on page 40.</td>
</tr>
<tr>
<td>This attribute</td>
<td>Is used to describe these characteristics</td>
<td>And may contain these values</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>
| FONT          | The name of the font. More than one font name can be specified, separated by commas. The first font available on a user’s computer will be used in the layout. **Note** Font values are case sensitive and must be entered in title case with initial capitals. | FONT = “Times New Roman”  
FONT = “Geneva”  
FONT = “New York, Times, Helvetica, Arial”  
Or any other available font (In FileMaker Pro Advanced, choose Format menu > Font to see the available fonts.) |
| HINT          | The name of the platform that the theme name is edited on and the character set. This attribute ensures that any upper-ASCII characters present in the THEMENAME value (for example, an accent over a letter in the theme’s name) will appear in FileMaker Pro Advanced on both Windows and Mac OS X. Japanese characters are supported if SHIFTJIS is specified. | HINT = “WIN”  
HINT = “MAC”  
HINT = “WIN/ROMAN”  
HINT = “MAC/ROMAN”  
HINT = “WIN/SHIFTJIS”  
HINT = “MAC/SHIFTJIS” |
| ONOFF         | Whether a field’s border should be displayed. | VALUE = “ON”  
VALUE = “OFF” |

<table>
<thead>
<tr>
<th>This attribute</th>
<th>Is used to describe these characteristics</th>
<th>And may contain these values</th>
</tr>
</thead>
</table>
| PARTNUMBER    | To distinguish multiple leading or trailing subsummary parts in a layout.  
This attribute is ignored for all other parts. FileMaker Pro Advanced supports values 0 through 9 and ignores any other value. | VALUE = “0”  
VALUE = “1”  
VALUE = “2”  
VALUE = “3”  
VALUE = “4”  
VALUE = “5”  
VALUE = “6”  
VALUE = “7”  
VALUE = “8”  
VALUE = “9” |
| PATTERN       | One of 64 valid patterns from the fill pattern palette in FileMaker Pro Advanced. Used for background fills in layout parts, fields, text, and field labels, and for borders of fields, field labels, and text.  
See “Using values for patterns and colors” on page 40. | PATTERN = “1”  
PATTERN = “47”  
PATTERN = “64”  
PATTERN = “NONE”  
PATTERN = “SOLID”  
PATTERN = “LTGRAY”  
PATTERN = “GRAY”  
PATTERN = “DKGRAY” |
| SIDES         | One to four sides on a field’s border.  
To describe all four sides, you can combine all four values.  
Or any combination, such as: | VALUE = “TOP”  
VALUE = “BOTTOM”  
VALUE = “LEFT”  
VALUE = “RIGHT”  
VALUE = “TOP BOTTOM LEFT RIGHT”  
VALUE = “LEFT TOP” |
<table>
<thead>
<tr>
<th>This attribute</th>
<th>Is used to describe these characteristics</th>
<th>And may contain these values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIZE (for the FONT element)</td>
<td>The point size for a font. Any valid point size can be specified.</td>
<td>SIZE = &quot;36&quot;</td>
</tr>
<tr>
<td></td>
<td>If a font size is unavailable on the computer or for a particular font, FileMaker Pro Advanced will substitute the closest size.</td>
<td>SIZE = &quot;12&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIZE = &quot;9&quot;</td>
</tr>
<tr>
<td>SIZE (for the PEN element)</td>
<td>Thickness in pixels for the outline of text blocks, field labels, and field borders.</td>
<td>SIZE = &quot;0&quot;</td>
</tr>
<tr>
<td></td>
<td>The value for NONE is &quot;0&quot; and the value for HAIRLINE is &quot;-1.&quot;</td>
<td>SIZE = &quot;-1&quot;</td>
</tr>
<tr>
<td></td>
<td>When applied to field borders, this pen size also applies to the line width of an EFFECT attribute (such as DROPShadow) and must have a value greater than zero.</td>
<td>SIZE = &quot;1&quot; through</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIZE = &quot;8&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIZE = &quot;12&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>This attribute</th>
<th>Is used to describe these characteristics</th>
<th>And may contain these values</th>
</tr>
</thead>
<tbody>
<tr>
<td>STYLE</td>
<td>Character styles for text in fields, text blocks, and field labels. More than one style can be specified, separated by commas or spaces.</td>
<td>STYLE = “PLAIN”</td>
</tr>
<tr>
<td></td>
<td>No error checking is done for contradicting styles, such as UPPERCASE and LOWERCASE.</td>
<td>STYLE = “BOLD”</td>
</tr>
<tr>
<td></td>
<td>The PLAIN style value overrides all other style values.</td>
<td>STYLE = “ITALIC”</td>
</tr>
<tr>
<td></td>
<td>STRIKEOUT and STRIKETHRU values are the same.</td>
<td>STYLE = “STRIKEOUT”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “STRIKETHRU”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “SMALLCAPS”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “UNDERLINE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “WORDUNDERLINE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “DBLUNDERLINE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “UPPERCASE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “LOWERCASE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “TITLECASE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “SUPERSCRIPT”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “SUBSCRIPT”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “CONDENSE”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “EXTEND”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STYLE = “ITALIC, BOLD, SMALLCAPS”</td>
</tr>
</tbody>
</table>
Specifying default values for themes

FileMaker Pro and FileMaker Pro Advanced use default values to replace attributes that are invalid or missing. For each theme listed in a theme file, you can specify whether the default values are determined by the current layout settings, which change when a user changes them, or by standard layout values, which are the same values that FileMaker uses when creating a file for the first time.

```xml
<THEMEDEFA ULT VALUE="CURRENT"/>
<THEMEDEFA ULT VALUE="STANDARD"/>
```

If you don’t specify a value for the THE MEDEFA U LT element in the theme, FileMaker Pro Advanced will use standard layout values by default.

Using values for patterns and colors

The values for the patterns in the FileMaker Pro and FileMaker Pro Advanced pattern palette are numbered consecutively, starting with the top row and counting from left to right, where the value for the pattern in the top left corner is 1. Five patterns in the first row can also be defined with words: NONE (= 1), SOLID (= 2), DKGRAY (= 6), GRAY (= 7), and LTGRAY (= 8).

Note The first pattern (value = 1) is transparent and the second pattern (value = 2) is solid. For objects with a color fill, be sure to use the solid pattern.

Themes use 6-digit color hexadecimal (hex) values to describe colors (for example, #CC9966), which can be found in most graphics programs that use a color palette.

Themes should use web-safe colors for databases that will be accessed by multiple platforms, displayed on monitors with varying resolutions, or displayed on a network. However, when your databases will be displayed on a single platform or at a high resolution, the full RGB color spectrum gives you a much larger and richer color set.

The FileMaker Pro and FileMaker Pro Advanced color palette contains only web-safe colors. For information on using the color palette, see Help. For more information about using patterns and colors in a layout, see Help.
Adding comments to theme files

You can add additional information to your XML theme files by enclosing the information in comment tags:

```xml
<!- - my comment here - ->
```

FileMaker Pro and FileMaker Pro Advanced will ignore any unknown (but syntactically correct) XML elements you may choose to include. This allows your theme files to be backward and forward compatible with other versions of FileMaker Pro and FileMaker Pro Advanced.

Checking theme files for errors

FileMaker Pro and FileMaker Pro Advanced cannot parse an XML theme document that is not well-formed, and they do not validate the XML in your documents. If one required item is missing or wrong, FileMaker Pro Advanced will ignore the entire document.

Here is a list of things to check for if your new layout themes don’t appear in the New Layout/Report assistant as expected:

- The theme filename has the .fth extension.
- The theme file is in text format.
- The theme file is located in the Themes folder inside the FileMaker Pro Advanced application folder.
- All required elements are there, including their start and end tags:
  ```xml
  <?xml version="1.0" standalone="yes" ?>
  <FMTHEMES>
  <FMTHEME>
    <THEMENAME VALUE="Purple and White Screen" />
  </FMTHEME>
  </FMTHEMES>
  ```
- All elements are complete. There are no missing attributes, values, quotation marks, start tags, or end tags.
- All values are enclosed in quotation marks (“value”). There are no missing opening or closing quotation marks, and there are no missing values (no blank quotation marks “ ”).
- All elements and attributes are spelled correctly.
- All attribute values are spelled correctly and are valid.
- Every single-line element ends with />.
- All multi-line elements are spelled correctly and their start and end tags match (for example, `<BODYPART>` and `</BODYPART>`).
Chapter 5

Developing third-party FileMaker plug-ins

If you are a C or C++ programmer and familiar with advanced calculations in FileMaker Pro and FileMaker Pro Advanced, you can create external function plug-ins that extend the feature set of the applications. The plug-ins can take advantage of recursion and looping or hook into other programming interfaces. Users can enable your plug-ins in FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, and FileMaker Server Advanced and use your external functions in their calculation fields and scripts.

Plug-ins must be registered with FileMaker. The FileMaker web site (www.filemaker.com) includes a plug-in registration form and a database of all the registered plug-ins. You can browse this database to get an idea of what kind of plug-ins already exist and use it to list your own plug-ins. For more information, see “Registering your plug-in” on page 53.

You can use FileMaker Server and FileMaker Server Advanced to ensure that FileMaker Pro clients always have the most current plug-in software installed on their computers. See FileMaker Server Guide to Updating Plug-Ins, available on www.filemaker.com/downloads.

About external functions

The FileMaker Pro Advanced CD includes an example plug-in project that you can modify to include your own external functions. Users can access your plug-ins through the Specify Calculation dialog box.

Follow these general steps to prepare your custom plug-ins:

1. Edit the example plug-in files to add your custom programming code.
2. Compile and test the customized plug-in.
3. Register your plug-in with FileMaker.
4. Install the compiled plug-in file for your users.

To access your external functions, your users:

1. Enable your plug-in through the Preferences dialog box.
2. Configure your plug-in, if required.
3. Define or edit a calculation field.
4. In the Specify Calculation dialog box, choose Function_Name(parameter 1...) as the calculation formula.

To see all external functions, select External functions from the View drop-down list.

About the example plug-in

The example plug-in project is designed to illustrate what a complete plug-in looks like. You can compile the example project files to create a plug-in with several external functions that users can access through the Specify Calculation dialog box. You can examine and modify the source code of the example files in any text editor.

The plug-in example includes seven external functions. See “Description of the FMExample plug-in’s external functions” on page 46.

The plug-in example files include all the source code required to compile the plug-in for the Windows and Mac OS X platforms. In addition to the plug-in source code, FileMaker Pro Advanced includes project files for Metrowerks CodeWarrior Development Studio, Microsoft Visual Studio .NET 2003 (also called Microsoft Visual C++), and Apple Xcode.
The example plug-in files are located in the English Extras\Examples\FMExample folder on the FileMaker Pro Advanced CD. The plug-in example source code files are located in subfolders in the FMExample plug-in folder. The following tables describe some of the folders and files.

### Contents of the FMExample folder

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example folder</td>
<td>Contains all of the files that are part of the FMExample.</td>
</tr>
<tr>
<td>Headers folder</td>
<td>Contains function definition files for the FileMaker API. Do not distribute to users who do not have licenses for FileMaker Pro Advanced.</td>
</tr>
<tr>
<td>Libraries folder</td>
<td>Contains library files for the FileMaker API. Do not distribute to users who do not have licenses for FileMaker Pro Advanced.</td>
</tr>
</tbody>
</table>

### Contents of the Example folder

<table>
<thead>
<tr>
<th>File/Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FMPluginExample.cpp</td>
<td>Contains code for implementation of the FMExample.</td>
</tr>
<tr>
<td>MacExample.fmplugin</td>
<td>Compiled Mac OS X plug-in package.</td>
</tr>
<tr>
<td>MacExample.mcp</td>
<td>CodeWarrior 8 project file.</td>
</tr>
<tr>
<td>MacExample.xcode</td>
<td>Apple Xcode project file.</td>
</tr>
<tr>
<td>WinExample.sln</td>
<td>Microsoft Visual Studio .NET project file.</td>
</tr>
<tr>
<td>WinExample.vcproj</td>
<td>Microsoft Visual C++ project file, used by WinExample.sln.</td>
</tr>
<tr>
<td>WinExample.fmx</td>
<td>Compiled Windows 2000, XP plug-in.</td>
</tr>
<tr>
<td>Support folder</td>
<td>Contains all additional resources and code used by FMPluginExample.cpp.</td>
</tr>
</tbody>
</table>
Installing, enabling, and configuring the example plug-in

External function plug-in files must be installed in the appropriate folder and enabled in FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced before they can be used. Some plug-ins must also be configured by the user.

Some plug-ins (and the libraries they reference) load only when the process is executed by a user who is logged into the system; FileMaker Server and FileMaker Server Advanced execute as a service, not as a user process. Consequently, you need to write plug-ins differently to work with FileMaker Server or FileMaker Server Advanced. Users will need to see their operating system documentation to find which libraries are typically available.

For information on installing web publishing plug-ins, see the FileMaker Server Advanced Web Publishing Installation Guide.

To install a plug-in, drag the plug-in file into the Extensions folder inside the FileMaker Pro 8 Advanced folder. In Windows, the plug-in extension must be .fmx. In Mac OS X, the plug-in extension must be .fmplugin.

To enable a plug-in:

1. Open the Preferences dialog box.
   - Windows: Choose Edit menu > Preferences.
   - Mac OS X: Choose FileMaker Pro Advanced application menu > Preferences.

2. Click the Plug-Ins tab.

3. Select the plug-in in the list.

A plug-in will appear in the list if it’s installed in the correct folder inside the FileMaker Pro Advanced application folder.

To configure a plug-in:

1. Select the plug-in in the Preferences dialog box.
2. Click Configure.

The Configure button is only available when the sixth character in the option string of the selected plug-in is “Y.” See “Option string syntax” on page 49.

3. Follow instructions in the configuration dialog box to configure the plug-in.
4. Click OK.
Description of the FMExample plug-in’s external functions

The FMExample plug-in provided in the Microsoft Visual C++, Apple Xcode, and CodeWarrior example projects adds the following external functions to FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, and FileMaker Server Advanced.

<table>
<thead>
<tr>
<th>Function’s name and parameter</th>
<th>Description of external function</th>
</tr>
</thead>
<tbody>
<tr>
<td>XMpl_Add (number1; number2)</td>
<td>Adds number1 and number2 together and returns the result. The function is the same as the plus operator in the calculation engine.</td>
</tr>
<tr>
<td>XMpl_Append (textToAppend ...)</td>
<td>Takes a multiple list of parameters, concatenates them, and returns the result. The function is the same as the ampersand operator in the calculation engine.</td>
</tr>
<tr>
<td>XMpl_Evaluate (calcToEvaluate)</td>
<td>Takes a simple or complex calculation, evaluates the calculation, and returns the result. Any calculation supported by FileMaker can be passed to this function. The function is identical to the Evaluate function in the calculation engine.</td>
</tr>
<tr>
<td>XMpl_NumToWords (number)</td>
<td>Returns a number in bank check format. For example 44.345 returns Forty-Four Dollars and 34 Cents. All digits beyond the second decimal place and any alphabetical characters are ignored.</td>
</tr>
<tr>
<td>XMpl_StartScript (filename; scriptname)</td>
<td>Runs the script specified by the scriptname parameter on the file specified by the filename parameter.</td>
</tr>
</tbody>
</table>

Function’s name and parameter | Description of external function |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>XMpl_UserFormatNumber (textOrNumber)</td>
<td>Returns the parameter as a text string formatted as specified in the configuration dialog box. Use this function to format text or numbers such as telephone numbers, postal codes, and so on. Formatting proceeds from right to left. Each # symbol in the format string is replaced by the next character in the parameter string. All remaining # symbols are replaced with zeros. This function demonstrates both client-only functionality and the plug-in configuration dialog.</td>
</tr>
<tr>
<td>XMpl_FormatNumber (formatString; textOrNumber)</td>
<td>The same as XMpl_UserFormatNumber, but formatString is provided as a parameter. This function illustrates a function that is visible in the Specify Calculation dialog for Auto Entry, and also supports calls from FileMaker Server, FileMaker Server Advanced, and Instant Web Publishing.</td>
</tr>
</tbody>
</table>

Using the example plug-in

To access the external functions:

1. Open the Preferences dialog box.
   Windows: Choose Edit menu > Preferences.
   Mac OS X: Choose FileMaker Pro Advanced application menu > Preferences.
2. Click the Plug-Ins tab.
3. Select FMExample.
   Because the example plug-in includes a function that requires configuration, the Configure button is enabled.
4. Click Configure.

The configuration dialog box that appears depends on how the plug-in source code was written. The XMpl_UserFormatNumber function in the FMExample plug-in displays the following configuration dialog box.
5. Click OK to use the default format or type a new format. The “#” symbols are replaced by numbers. All other text in the format string is retained as is.

6. Click OK to close the Preferences dialog box.

7. In FileMaker Pro Advanced, choose Define menu > Database > Fields tab.

8. Create a calculation field.

9. In the Specify Calculation dialog box, choose External Functions from the View drop-down list.

10. Double-click an external function to add it to the formula box. All external function calls require the name of the external function to call and the function’s parameter value, even if the value is null.

11. Replace the parameter placeholder with the required parameter or parameters for the function.
12. Continue to build the formula then and click **OK** when you’re done.

13. Click **OK** to close the Define Database dialog box.

**Customizing the plug-in example**

The plug-in example in FileMaker Pro Advanced is designed to be easily modified so you can add your own custom functions. You need to modify the following items:

- version information in FMPluginExample.strings and FMPluginExample.rc
- plug-in and function names in FMPluginExample.strings and FMPluginExample.rc
- configuration function in FMPluginPrefs.cpp
- external function definitions and coding in FMPluginFunctions.cpp

**Customizing the example resources**

You must make the following modifications to the plug-in resource files to create a custom external function plug-in:

- Modify the version variables and strings to meet your needs.
- Revise the configuration dialog box to meet your needs.
- Specify the correct option string values.
- Edit plug-in names and description.
- Define your function names and function prototypes.

**Customizing FMPluginExample.cpp**

Make your modifications to the FMPluginExample.cpp in the functions listed in the following table.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Customization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do_PluginInit</td>
<td>Provide your own unique plug-in ID for “pluginID.” Register each function, providing its name, description, and function to be used. Call fmx::ExprEnv::RegisterExternalFunction to register your functions.</td>
</tr>
<tr>
<td>Do_PluginIdle</td>
<td>Add any idle processing your plug-in needs.</td>
</tr>
<tr>
<td>Do_PluginShutdown</td>
<td>Revise the UnRegisterExternalFunction calls to reverse the registration done in Do_PluginInit. Call fmx::ExprEnv::UnRegisterExternalFunction to unregister your functions.</td>
</tr>
</tbody>
</table>

**Customizing FMPluginPrefs.cpp**

This file contains the Do_PluginPrefs function for the implementation of the configuration dialog box. Revise or remove this code as needed.

**Customizing FMPluginFunctions.cpp**

Revise or remove the functions provided in the FMPluginFunctions.cpp file and define your own. Do_PluginInit refers to these functions when evaluating external functions in calculations.
Requirements for writing external function plug-ins

FileMaker plug-ins are most useful when they contain a single function or a set of functions with similar features. When you design your plug-in, keep in mind that developers who use your plug-in may not understand programming conventions that you take for granted. The format of each function’s parameter should be understandable to the typical user.

If you are creating a FileMaker plug-in with functions that do not require any parameters, make sure the function “prototype” registered for that function does not include parentheses. For example, “DoThis” should be registered instead of “DoThis( )” as the function prototype.

API code files

There are ten API code files in the Headers folder: FMXExtern.h, FMXCalcEngine.h, FMXBinaryData.h, FMXDateTime.h, FMXTextStyle.h, FMXTypes.h, FMXFixPt.h, FMXClient.h, FMXText.h, and FMXData.h. The files are not redistributable in source code (or human readable) form, cannot be modified, and are only provided to enable licensees of FileMaker Pro Advanced to compile plug-ins for use with FileMaker products. Not all the files are required to build all types of plug-ins.

The FMXExtern.h is absolutely required. The FMXExtern.h defines the parameter block (the shared data structure used by your plug-in and FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced) and some shared function calls. The function calls are used to manipulate the parameter and result handles in the parameter block.

The FMXExtern.h file defines the call-back functions for backward compatibility operations and the different kinds of plug-in events (FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced messages) sent to the plug-in in a FMExternCallSwitch definition.

FMEexternCallStruct defines the structure of the parameter block. FMEexternCallPtr is a pointer to that structure and gFMEexternCallPtr is a global variable that should be defined in your code.

The FMXCalcEngine.h file contains the register and unregister functions. It will be used in most plug-ins, as the plug-ins will likely need to register functions.

The functionality of the remaining API code files is described in comments that are included in the files themselves.

Option string syntax

The option string must be 11 characters long for plug-ins.

The first four characters of the option string are the ID of the plug-in. The ID must be unique for each plug-in and must not begin with “F,” “FM,” or “Web.” For the Mac OS X, it is recommended that you set the creator type of the plug-in to this same value. The ID can only contain low-ASCII alphanumeric characters (such as 0-9, A-Z, and a-z).

Note: So that there will be a good chance of having a unique ID, you should register the ID at the Apple Developer Support web site, even if you won’t be creating a Mac OS X version of your plug-in. To register plug-in IDs as Creator codes, go to the developer pages on the Apple Computer web site at www.apple.com. For more information, see “Registering your plug-in” on page 53.

The fifth character of the option string is always “1” and the eight, tenth, and eleventh are always “n.” Other values for these flags are reserved for FileMaker use only.

For example, “Moc31YnnYnn” is a option string for a plug-in with the ID of “Moc3” (characters 1-4) that requires configuration (character 6 = “Y”), uses the new style registration and functions callbacks (character 7 = “n”), and requires special idle time (characters 9 = “Y”).
**Table of option string characters**

<table>
<thead>
<tr>
<th>Characters in the option string</th>
<th>Description of characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-4</td>
<td>Characters 1-4 are the plug-in ID. Register the ID as a Creator code on the Apple Developer Support web site at <a href="http://www.apple.com">www.apple.com</a>.</td>
</tr>
<tr>
<td>5</td>
<td>Character 5 is always “1.”</td>
</tr>
<tr>
<td>6</td>
<td>Set the sixth character of the option string to “Y” if you want to enable the Configure button for plug-ins in the Preferences dialog box. Use “n” if there is no plug-in configuration needed. If the flag is set to “Y,” then make sure to handle the kFMXT_DoAppPreferences message. For more information, see “FileMaker messages sent to the plug-in” on page 50.</td>
</tr>
<tr>
<td>7</td>
<td>Set to “n” for the new style plug-in registration and function callbacks demonstrated in the FMExample. Only set to “Y” if your plug-in requires the legacy function string list and single external callback.</td>
</tr>
<tr>
<td>8</td>
<td>Character 8 is always “n.”</td>
</tr>
<tr>
<td>9</td>
<td>Set the ninth character of the option string to “Y” if the kFMXT_Idle message is required. For simple external functions this may not be needed and can be turned off by setting the character to “n.”</td>
</tr>
<tr>
<td>10</td>
<td>Character 10 is always “n.”</td>
</tr>
<tr>
<td>11</td>
<td>Character 11 is always “n.”</td>
</tr>
</tbody>
</table>

**Naming conventions for external functions**

The function name prefix for all of the plug-in’s external functions must be a unique value containing four or five characters and must not begin with the characters “FM” or “Web.” Four-character prefixes are reserved by FileMaker. For example, the FMPluginExample plug-in’s function name prefix is “XMpl.”

FileMaker will manage the naming conventions for plug-in name, filename, and function prefix. For this reason, you need to register your plug-in. FileMaker has reserved certain naming conventions for external functions. For more information, see “Registering your plug-in” on page 53.

### FileMaker messages sent to the plug-in

There are six possible calls that FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced can request of your plug-in. Messages sent to your plug-in are supplied in the whichCall field of the parameter block, FMExternCallStruct, defined in the FMXExtern.h file.

- **kFMXT_Init** — the Initialization message
- **kFMXT_Shutdown** — the Shutdown message
- **kFMXT_Idle** — the Idle message
- **kFMXT_DoAppPreferences** — the Preferences message
- **kFMXT_External** — the External Function message received by legacy plug-ins that set character 7 in the options string to “Y” and that register their functions the old external way
- **kFMXT_GetString** — the GetString message received by plug-ins that use the new style of registration when the plug-ins provide the option string, plug-in name, and description

#### Initialization message

The Initialization message, kFMXT_Init, is sent to the plug-in whenever it is enabled in FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced. This may or may not correspond with the startup of the application, depending on whether the plug-in is enabled in the Preferences dialog box.
There are two possible result values that the plug-in should return in response to the Initialization message:

- **kBadExtnVersion** should be returned if the version number passed is less than the value of **kMinExtnVersion** or greater than the value of **kMaxExtnVersion**. This prevents the plug-in from running on an API that is incompatible with the API with which it was compiled.

- **kCurrentExtnVersion** is the only other result value that should be returned. This causes the plug-in to be enabled.

For the FMPluginExample plug-in, the Do_PluginInit function is called when the Initialization message is received. The Do_PluginInit function first checks the version of the API that the plug-in was compiled with to verify that it’s compatible with the version of FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced that has loaded it. Then the function checks for preferences and sets them if they exist. If no preferences currently exist, it will create them with default values.

In Windows, these preferences are stored as registry entries. In Mac OS X, they are stored in a file within the Preferences folder of the System Folder. Due to the differences between the way this information is stored on the two platforms, the Do_PluginInit function uses preprocessor instructions to choose the correct code at compile time.

If the preferences are set properly and the API version is correct, the Do_PluginInit function in the FMPluginExample plug-in will return **kCurrentExtnVersion**.

After you set the preferences, register each external function by providing its name, description, and the function to be used. Use `fmx::ExprEnv::RegisterExternalFunction` to register your functions.

### Shutdown message

The Shutdown message, **kFMXT_Shutdown**, is sent to the plug-in whenever it is disabled in FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced. This may or may not correspond with the quitting of the application, depending on whether the plug-in is disabled in the Preferences dialog box.

The FMPluginExample plug-in does not allocate any persistent memory on the heap, and therefore does not do anything when it receives the Shutdown message. You should implement a clean-up function in your plug-in, however, to deallocate anything you have on the heap and exit from any operating system services you may be using. It’s possible for a plug-in to be enabled and disabled multiple times during a session, so it’s important for your plug-in to clean up memory.

Unregister each external function registered during the Initialization message using `fmx::ExprEnv::UnRegisterExternalFunction`.

### Idle message

The Idle message, **kFMXT_Idle**, is only sent to the plug-in during idle time if the idle feature flag was set to “Y” in the option string and the plug-in is currently enabled.

There are five times when this message is called by the FileMaker application.
If the idleLevel parameter is not zero, then the routine has been called while the application is running a script or is being controlled by the user. One of the following four messages has been sent:

<table>
<thead>
<tr>
<th>Message</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>kFMXT_UserNotIdle = 1</td>
<td>The user has done something within the last 30 seconds.</td>
</tr>
<tr>
<td>kFMXT_ScriptPaused = 2</td>
<td>The user is running a script that has been paused.</td>
</tr>
<tr>
<td>kFMXT_ScriptRunning = 3</td>
<td>The user is running a script.</td>
</tr>
<tr>
<td>kFMXT_Unsafe = 4</td>
<td>Same as if the unsafeCalls parameter is set to true.</td>
</tr>
</tbody>
</table>

Do not perform any lengthy, user interface, or event processing when the idleLevel parameter is not zero.

The Idle message will also be sent when the application detects free time and does its own internal idle handling.

<table>
<thead>
<tr>
<th>Message</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>kFMXT_UserIdle = 0</td>
<td>The user hasn’t done anything within the last 30 seconds or more.</td>
</tr>
</tbody>
</table>

**Preferences message**

The Preferences message, kFMXT_DoAppPreferences, is sent in response to a user clicking the Configure button for the selected plug-in in the Preferences dialog box.

The plug-in should display a dialog box that will allow the user to set any specific configuration data required by the plug-in. If the plug-in requires user-definable preferences, you should implement your user interface here. The Configure button will only be enabled if the sixth character of the option string is set to “Y.” For more information, see “Option string syntax” on page 49.

Any options that need to be saved should be placed in their own registry entry (Windows) or in their own preference file (Mac OS X).

The FMExample plug-in needs to implement a configuration dialog box for the XMpl_UserFormatNumber function, so the flag has been set in the option string (XMplYYnnnnn) and the function Do_PluginPrefs is called when the Preferences message is received.

**External Function message**

The External Function message, kFMXT_External, is a legacy message for old style plug-ins. It is no longer required for plug-ins that are registered in the new style.

**GetString message**

The GetString message, kFMXT_GetString, is sent to the plug-in when FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced want to retrieve one of the following strings from the plug-in. The plug-in developer can decide where to store the strings.

<table>
<thead>
<tr>
<th>String</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>kFMXT_OptionsStr = 131</td>
<td>The option string</td>
</tr>
<tr>
<td>kFMXT_NameStr = 128</td>
<td>The plug-in name</td>
</tr>
<tr>
<td>kFMXT_AppConfigStr = 129</td>
<td>The help text to display in the Preferences dialog box</td>
</tr>
</tbody>
</table>

**Avoiding potential Mac OS X resource conflicts**

Problems can occur on Mac OS X machines if your plug-in has the same ID for a resource that FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, FileMaker Server Advanced, or another plug-in has for the same type of resource.
To avoid potential resource ID conflicts with your plug-in and other applications or plug-ins, follow these guidelines:

- **Use ID numbers between 23,000 and 24,999**
  Use hard-coded IDs from this range for your dialog boxes, sounds, icons, and other resources to avoid conflicts with FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced resources. FileMaker does not use any of the IDs in this range for the application resources.

- **Set the current resource file to your plug-in**
  To avoid conflicts with other plug-ins that use the same resource IDs, use the Mac OS X toolbox call in the Resource Manager to set the current resource file to your plug-in before getting any resource objects from the resource file.

  Include the following line before any line that references or uses a resource:

  ```
  UseResFile (pb -> resourceID) ;
  ```

  When FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, or FileMaker Server Advanced loads your plug-in, the application gives the resource ID. This is located in the parameter block near the param2 and param3 variables in the FMExtern.h file. For more information, see “API code files” on page 49.

---

### Registering your plug-in

Register your external function plug-in with FileMaker to ensure that it’s unique and not in use by any other plug-in. Registering also allows you to make your plug-in visible to customers searching for a plug-in to suit their needs.

Before registering your plug-in, you can search to see if the plug-in name or option string ID you are requesting has already been assigned.

You must register each plug-in separately. To register your plug-in, go to www.filemaker.com/developers.

---

### Revising a registered plug-in

If you need to revise information about a plug-in that is already registered to you, you must send an email message to FileMaker at plugins@filemaker.com. Please be sure to provide the following information:

- the registration ID number that was assigned to you when you first registered your plug-in
- your name
- your full company name
- your daytime phone number
- the name of the plug-in with registered information you want to revise

Include any changes you want to make. If applicable, send the revised plug-in file. A confirmation of the revision will be sent to you.

---

### Providing documentation for your plug-in

Your plug-in should include an example database file with any special fields and scripts necessary to demonstrate the use of the plug-in’s external functions. In addition, you should provide documentation that describes each external function and its parameters.

For ideas on how to document your plug-in, see other external function plug-ins registered with FileMaker at www.filemaker.com.
Chapter 6  
Debugging, analyzing, and optimizing files

The FileMaker Pro Advanced features explained in this chapter are:

- the Script Debugger for systematic testing and debugging of FileMaker scripts
- the Data Viewer for monitoring fields, variables, and calculations
- the Disable script step feature for testing portions of a script
- the Database Design Report feature for publishing comprehensive documentation on database schema and options
- the File Maintenance features for compacting the size of database files and improving their performance

Debugging and troubleshooting scripts

With FileMaker Pro Advanced, you can:

- step through scripts one step at a time
- view and track sub-scripts
- monitor fields, variables, and calculations
- disable script steps

Stepping through scripts

Use the Script Debugger to step through scripts in FileMaker databases. The Script Debugger enables you to execute your scripts step-by-step to view issues that may arise as the script is performed.

The Script Debugger recognizes the privileges attached to each script. A script will only appear in the Script Debugger if you have editing privileges for the script and the access privileges for the script are set to Modifiable.

If a script with access privileges set to Modifiable performs a script with Executable Only access, the Executable Only script will perform in its entirety without showing its steps in the Script Debugger. If an Executable Only script performs a script with privileges set to Modifiable, only the steps in the Modifiable script will appear in the Script Debugger. For more information about script privileges and running scripts with full access, see Help.

To run scripts in debug mode, select Tools menu > Debug Scripts.

Tip To enable the Script Debugger from the Define Scripts dialog box, press Shift and click the Perform button. To disable the Script Debugger, press Ctrl (Windows) or Command (Mac OS) and click the Perform button. For more information on keyboard shortcuts, see Help.
### Choose

<table>
<thead>
<tr>
<th>Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>Execute the script one step at a time.</td>
</tr>
<tr>
<td></td>
<td>If the script step is Perform Script, the Script Debugger will</td>
</tr>
<tr>
<td></td>
<td>execute the sub-script and proceed to the next line of the calling</td>
</tr>
<tr>
<td></td>
<td>script. The Script Debugger will execute all sub-script steps until</td>
</tr>
<tr>
<td></td>
<td>it encounters a breakpoint.</td>
</tr>
<tr>
<td>Step Into</td>
<td>Execute the script one step at a time.</td>
</tr>
<tr>
<td></td>
<td>If the script step is Perform Script, the Script Debugger will</td>
</tr>
<tr>
<td></td>
<td>step to the first line of the sub-script and await user input</td>
</tr>
<tr>
<td></td>
<td>before proceeding to the next sub-script step.</td>
</tr>
<tr>
<td>Step Out</td>
<td>Execute all script steps in the current script and, if the script is</td>
</tr>
<tr>
<td></td>
<td>a sub-script, return to the line after the Perform Script step in the</td>
</tr>
<tr>
<td></td>
<td>calling script.</td>
</tr>
<tr>
<td></td>
<td>If the script is not a sub-script, the Step Out command will</td>
</tr>
<tr>
<td></td>
<td>cause the Script Debugger to execute all script and sub-script</td>
</tr>
<tr>
<td></td>
<td>steps until it encounters a breakpoint.</td>
</tr>
<tr>
<td>Run</td>
<td>Execute all script steps until a breakpoint is encountered.</td>
</tr>
<tr>
<td>Halt Script</td>
<td>Halt execution of a script and close Script Debugger.</td>
</tr>
<tr>
<td>Set Next Step</td>
<td>Set the step execution pointer to the highlighted script step.</td>
</tr>
<tr>
<td></td>
<td>This command passes control to the highlighted step but does not</td>
</tr>
<tr>
<td></td>
<td>perform the step. The highlighted step is performed when script</td>
</tr>
<tr>
<td></td>
<td>execution is resumed. Any script steps between the last executed step</td>
</tr>
<tr>
<td></td>
<td>and the assigned next step are not executed. Click a step to</td>
</tr>
<tr>
<td></td>
<td>highlight it, then click the Set Next Step button.</td>
</tr>
<tr>
<td>Set/Clear Breakpoint</td>
<td>Set or clear a breakpoint from the selected line. Breakpoints can be</td>
</tr>
<tr>
<td></td>
<td>set or cleared from the Script Debugger or from ScriptMaker. Breakpoints</td>
</tr>
<tr>
<td></td>
<td>are saved with the file that contains the script. Breakpoints are</td>
</tr>
<tr>
<td></td>
<td>ignored by FileMaker Pro and when the Script Debugger is not in use.</td>
</tr>
<tr>
<td></td>
<td>Breakpoints allow the Script Debugger to perform large sections of the</td>
</tr>
<tr>
<td></td>
<td>script that do not need to be looked at closely.</td>
</tr>
</tbody>
</table>

### Choose

<table>
<thead>
<tr>
<th>Action</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Breakpoints</td>
<td>Clear all the breakpoints from the current script.</td>
</tr>
<tr>
<td>ScriptMaker</td>
<td>Halt script execution and open ScriptMaker so you can edit the script.</td>
</tr>
<tr>
<td>Data Viewer</td>
<td>Open (or close) the Data Viewer window so you can monitor specified</td>
</tr>
<tr>
<td></td>
<td>fields, variables, and calculations.</td>
</tr>
</tbody>
</table>

**Note** In order to facilitate proper script debugging, the Script Debugger overrides some script steps. The Allow User Abort script step with the option set to off will not prevent you from stopping the execution of a script. The Adjust Window script step with the options of hide or minimize will not hide or minimize the window when encountered through the Step or Step Into buttons.

### Viewing sub-scripts

You can view sub-scripts when you step through scripts in the Script Debugger. For example, if Script A calls Scripts B, which then calls Script C, you can view the steps in all three scripts.

To view sub-scripts:

1. Enable the Script Debugger. See “Stepping through scripts” on page 55.
2. Select a script step that calls a sub-script.
3. Click the Step Into button.
4. Select a script in the Active Script list to view that script’s steps in the display area.

**Note** The Set Next Step feature is only available for the currently executing script.
Monitoring fields, variables, and calculations

You can use the Data Viewer to monitor expressions like field values, local and global variables, and calculations. You can monitor expressions while running scripts or while testing them in the Script Debugger. You can also monitor field values and variables in the database file.

To monitor fields, variables, and calculations:
1. Choose Tools menu > Data Viewer, or click  in the Script Debugger window.
2. Do the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an expression</td>
<td>Click  +  .</td>
</tr>
<tr>
<td>Edit an expression</td>
<td>Click  or double-click the expression in the list.</td>
</tr>
<tr>
<td>Duplicate an expression</td>
<td>Select one or more expressions, then click  +  .</td>
</tr>
<tr>
<td>Delete an expression</td>
<td>Select one or more expressions, then click  -  .</td>
</tr>
</tbody>
</table>

3. In the Edit Expression dialog box, select the database file containing the expression, then build or edit the expression you want to monitor.

4. Click Evaluate Now to display the results of an expression, or click Monitor to add the expression to the Data Viewer.

5. In the Data Viewer window, click Refresh Values to refresh the calculations in the list.
Keep these points in mind:

- To monitor fields, variables, and calculations of a currently executing script, add them to the Data Viewer list before running the script in the Script Debugger.
- Expression values in the Data Viewer automatically refresh when using the Script Debugger.
- Expressions in the Data Viewer window are not removed until you remove them.
- You can add local and global variables to the Data Viewer. Local variables begin with “$” and global variables begin with “$$”. For more information about variables, see Help.
- Click Refresh Values to update the values for calculations that are visible in the list. Values update as you scroll through the list.

**Disabling script steps**

You can disable and enable script steps to test portions of a script. When you execute a script, disabled script steps are skipped.

To disable script steps:

   Or, click the ScriptMaker button in the Script Debugger window.
2. In the Define Scripts dialog box, select the script, then click Edit (or double-click the script name).
3. In the Edit Script dialog box, select one or more script steps, then click Disable or Enable.
**Documenting database schemas**

Use the Database Design Report (DDR) feature to document the schema of your database and publish it to an HTML or XML file. You can choose which elements and database tables in the database you want to report. The HTML version of the report is hyperlinked and you can view or print it in a Javascript-enabled web browser.

With the Database Design Report feature you can:

- examine a textual representation of your database schema
- gather statistics on the structure of your database
- use the information in the report to recreate the structure of your database if you lose the original database files
- troubleshoot missing references, broken relationships, calculations, and more

A Database Design Report in HTML format includes a Report Overview that provides a snapshot of the elements in each database file. The Report Overview contains hyperlinks to details about all elements in each database file. A Database Design Report in XML format contains the same information, ready to be transformed into the format you require. You can create tools that can use the DDR XML to analyze or process the structure of databases. For more information, download the FileMaker Pro Advanced *Database Design Report XML Output Grammar* PDF, available at www.filemaker.com/downloads.

To create a Database Design Report:

1. Open all database files for which you want to produce a Database Design Report.
   You must have full access privileges for any file for which you want to produce a Database Design Report and the file must be open in FileMaker Pro Advanced. You can run a Database Design Report on local or remote files.


3. In the Available Files list, clear any files that you want to exclude from the report by clearing the checkbox associated with the file.

4. If there are any files that contain tables that you want to exclude from the report, select the file in the Available Files list.

Database Design Report dialog box

The tables in the file appear in the Include fields from tables in selected file list. You can then deselect any table in the list.

By default, all tables in all selected files are reported.
5. Clear elements that you want to exclude from the report.
By default, all elements in all selected files are reported. Each selected
element, if present, will be reported on for each selected file.
6. If you do not want the report to be published in the default HTML
format, select XML in the Report Format section.
7. If you do not want the report to automatically open when done,
clear the checkbox for this option in the File Handling section.
8. Click Create.

Troubleshooting files with the DDR HTML output
You can use the Database Design Report to identify problem areas in
your database. For example, you can search the DDR output for the
following text to locate problems:
- Missing Field
- Missing Table Occurrence
- Missing Base Table
- Missing File Reference
- Missing Layout
- Missing Value List
- Missing Custom Function
- Missing Script
- Missing Account
- Missing Privilege Set
- Missing Extended Privilege
- Missing Custom Menu
- Missing Custom Menu Set

Keep these points in mind:
- If you have any inactive accounts that have a blank password, the
  DDR HTML output displays a password mask “******”. In the XML
  output, the emptyPassword=”” node will report FALSE. To get
  accurate password information from these inactive accounts, make the
  accounts active and select View Source.
- Mac OS: To view the HTML report, use web browsers such as
  Safari, Mozilla, and Firefox. Internet Explorer for Mac OS is not
  supported.
- Mac OS: To view a DDR in XML format using the Safari web
  browser, open the file in Safari, then choose View menu > View Source.
- The Database Design Report feature creates XML files in UTF-16
  format. To view a report in this format, use a text editor or web
  browser that supports UTF-16 text.

Compressing and optimizing files
Use the File Maintenance feature to improve the performance of your
database files. The Compact File option removes free disk space from a
file, reducing the file size and streamlining data access. The Optimize
File option improves file access speed by moving logically related data
closer together. Both features reduce disk-head movement.
Improvements will be especially noticeable when you are using large
files and performing finds or sorts, or executing scripts that operate on
all records.
The Compact File option compresses the file by removing free space,
combining partially full disk pages and eliminating gaps in the data.
This feature is useful in reducing the size of a database file. If there is
going to be more data added to the file, you might not want to use the
Compact File feature, as it will increase the amount of fragmentation
occurring when new data is written to the database in the future. If you
do add data to a file that has been compacted, you can defragment it
with the Optimize File feature.
The Optimize File option defragments the file to make the physical arrangement of data match the logical arrangement. This feature is especially useful for increasing the speed at which finds and sorts are performed on files with a large number of records. You can use the Optimize File feature at any time, even on databases that will have data added to them.

Both File Maintenance options work on the currently open database file, without creating another copy. If you are hosting files, networked clients will not have access to the file maintenance features for those files.

You can use the options together or by themselves. You can cancel the operation of the features at any time with the compression and defragmentation that has been performed up to the point of cancellation still retained.

1. Open a database file.
2. Choose Tools menu > File Maintenance.
3. Select one or both options, then click OK.

A File Maintenance Status dialog box shows you the progress of the features. An alert dialog box tells you when file maintenance is complete.
Chapter 7
Using the Developer Utilities

FileMaker Pro Advanced provides Developer Utilities that let you:

- bind your database files into a stand-alone runtime database solution that does not require FileMaker Pro or FileMaker Pro Advanced in order to be used on a computer
- rename all of your database files and automatically update the internal links to related files and scripts
- display your database files in Kiosk mode
- remove administrative access from all accounts and prevent users from modifying most design or structural elements of your databases
- add the FileMaker Pro filename extension to your files
- add your own logo or graphic to the closing splash screen of your stand-alone runtime database solution

Before you begin to build your database solution, you need to decide how users will interact with it. Your database solution might have any of the following components:

- a primary database file that connects all of the auxiliary files
- scripts and buttons to open and close auxiliary files, return to the primary file, display a splash screen layout at startup, or quit a runtime application
- common elements and a consistent appearance for cross-platform solutions
- a custom layout theme used for every file in the solution
- an About layout to introduce your solution
- a custom Help system that provides usage tips for your solution
- multiple privilege sets that can specify levels of access to layouts, menus, specific tables, record, fields, and so on
- password-protected accounts assigned to privilege sets that determine the level of access of account users

Note FileMaker Pro and FileMaker Pro Advanced now allow you to include as many database tables as you need in a database file. This capability eliminates one of the main reasons for using multiple files. However, other elements, like scripts and access privileges, are stored at the file level and so some complex solutions will still benefit from using multiple files.

Overview of preparing your solution files

As you design, build, and test your database solution, keep in mind how users will interact with it. This includes navigational scripts and buttons, effective use of layouts and themes, and Help for the user.

The Developer Utilities are used to modify sets of database solution files. This chapter describes three main stages in the process:

1. To modify database solution files without creating a runtime database solution, see “Modifying database solution files” on page 64.
2. To prepare files for a runtime database solution and ensure that their file references will work in the solution, see “Considerations for a runtime database solution” on page 66.
3. To create a runtime database solution, see “Binding databases into runtime database solutions” on page 68.
Here are some general considerations for preparing solution files:

- If desired, create a custom theme for all the layouts in your database solution. See “Creating custom layout themes” on page 31 for information.

- If you’re creating a solution that will have versions for Windows and Mac OS X, test the different versions of the solution on their respective platforms. For more information, see Help.

- If you have used multiple files instead of multiple tables in a single file, all files for your solution should be in the same folder before being bound into a runtime solution. If it is not practical to keep all files in one folder, be sure to include a file reference to each file that is just the filename. See “Checking file references” on page 67.

- Make sure to specify every file that’s related to the solution, so that if you modify filenames all file references will be updated.

- If you have used multiple database files, decide which file will be the primary file that users open first. The primary file stores the custom settings. Use this file for navigation buttons or scripts to other auxiliary files, an About layout, a custom Help layout or file, and to quit the application.

- Create scripts and buttons for users to navigate from the primary file to auxiliary files and layouts in the solution. See “Using scripts and buttons to control your solution” on page 18.

- Create documentation about your database solution. See “Providing user documentation” on page 79.

- Although the Developer Utilities use a copy of a file instead of the original, it’s always a good idea to make a backup copy of your original files before beginning.

---

**Modifying database solution files**

Use the Developer Utilities to produce a new set of database files, to customize them, or to create a runtime database solution.

**Note** You must convert database files from versions of FileMaker Pro earlier than 7.0 before you can use them with the Developer Utilities. For more information about converting files, see the conversion information in the *FileMaker Pro User’s Guide*.

To use the Developer Utilities:

1. Close all of your database files that you are going to customize.

2. Choose Tools menu > Developer Utilities.

3. If you have used the Developer Utilities on the same database solution before and saved your settings, click Load Settings.

   A Select a file dialog box opens so that you can browse to find your settings file. See “Saving and reusing Developer Utilities settings” on page 71.

4. Click Add to locate the files that you want to customize.

5. When you have added all the files that you want to customize, do one or more of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the primary file</td>
<td>Double-click the file in the list.</td>
</tr>
<tr>
<td>Rename a file</td>
<td>Select the file in the list, type the new name in the Rename file box, and click Change. <strong>Note</strong> Do not type a filename extension. See “Choosing filenames for runtime database solutions” on page 69.</td>
</tr>
<tr>
<td>Remove a file</td>
<td>Select the file in the list and click Remove.</td>
</tr>
</tbody>
</table>
6. Under Project Folder, click Specify to choose the location in which the copy of the database solution will be saved.

7. In the Choose a folder for this project’s files dialog box, select or create a folder and click OK (Windows) or Choose (Mac OS X).

8. If you do not want the new files to overwrite earlier versions of them, clear the Overwrite matching files within the Project Folder checkbox.

   **Important** If Overwrite matching files within the Project Folder is selected, the Developer Utilities will overwrite files with the same names as those in the list of files.

9. Do one of the following:
   - To customize your database files or bind the files to a runtime solution, under Solution Options click Specify.
   - To create a copy of your database files with new names, skip to step 13.

10. In the Specify Solution Options dialog box, select one or more options.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Bind databases to runtime applications** | Choose Create Runtime solution application(s)  
   See “Binding databases into runtime database solutions” on page 68.  
   **Note** This option can be combined with all others, except Databases must have a FileMaker file extension. |
| **Permanently prohibit any administrative access to your solution** | Choose Remove admin access from files permanently  
   See “Removing full access privileges from databases” on page 73.  
   **Important** Once removed, administrative access cannot be restored to the custom solution. |
| **Force accounts without full access privileges to open your solution in Kiosk mode** | Choose Enable Kiosk mode for non-admin accounts  
   See “About Kiosk mode” on page 16. |
| **Add the FileMaker extension to the filenames of database files** | Choose Databases must have a FileMaker file extension  
   **Note** This option is not available if you select Create Runtime solution application(s). You can use this feature to add extensions to files that do not have extensions. |
| **Create a log file to record any errors encountered during processing** | Choose Create Error log for any processing errors  
   See “Creating an error log” in the next section. |

11. Click OK.
12. To be able to quickly repeat the process, click **Save Settings**, and choose a folder and location for your settings file. See “Saving and reusing Developer Utilities settings” on page 71.

13. Click **Create**.

The Developer Utilities copy all the selected database files, with the modifications made by the Utilities, to the Project Folder. If the default option to overwrite the destination files has been left on, the specified Project Folder will be used to store the files copied by the Developer Utilities. If the default option to overwrite the files has been cleared, the specified Project Folder will be used if it is empty or a new one based on the name of the Project Folder will be created.

**Creating an error log**

Some errors do not trigger error messages. An error log will capture more detail on any errors encountered during processing.

To create an error log:

1. In the Specify Solution Options dialog box, select the **Create Error log for any processing errors**.
2. Click **Specify**.

If you don’t specify a filename and location for the error log, it will be saved to the project folder with the filename Logfile.txt.

3. Use the Specify a file dialog box to select a location and provide a filename for the error log.

If an error occurs during the processing of the options, the error is logged in the error log. An error message may also indicate that an error has been encountered.

---

**Considerations for a runtime database solution**

You should address the following issues before binding the files to the runtime application.

- **Do you want users to open and close auxiliary files?**

  In the runtime application, there are no menu options to open or close files. If you want users to open and close auxiliary files, you must provide scripts in your solution to perform these operations. In each auxiliary file you must place a button or startup script that returns users to the primary file.

- **Do you want users to be able to modify the database?**

  Unless your runtime database solution files are password protected, users can open and modify the files in FileMaker Pro or FileMaker Pro Advanced. You can also make your files permanently unmodifiable. See “Removing full access privileges from databases” on page 73.

- **Will this be a runtime database solution used on both platforms?**

  See “Binding files for both platforms” on page 68.

- **How will you provide updates for your users?**

  You can make it easier for users to update your runtime database solution files by providing scripts in your primary file to export their data and import it into the updated solution. See “Importing data into upgraded runtime solutions” on page 72.
Will your users be printing reports or other information from your runtime database solution?
It’s a good idea to set document margins if your runtime database solution will be printed from a variety of printers. For more information, see Help.

Do you want users to be able to perform spell checking on records?
You can change the main spelling dictionary language for your database solution by choosing one from the dictionaries supplied with FileMaker Pro Advanced. Your users can add or modify a user-defined dictionary to the runtime application. For more information, see Help.

Are your original database solution files in more than one folder?
See “Checking file references” in the next section.

Checking file references
A file reference stores the path or paths that the runtime application searches to access an external table, script, or value list. Each file reference can consist of one or more paths, separated by carriage returns. File paths are searched in the order in which they appear. The runtime application opens the first file it is able to locate. For more information, see Help.

Tip You may want to put multiple tables in one file and so avoid any potential difficulties with multiple files.

During the development of a database with multiple files, you may want to have some of the files in separate folders. During the creation of a runtime database solution, however, all files are moved into the same folder as the runtime application. Your file references should take this into consideration, whether your solution starts out in one folder or not.

For this reason, every file reference must include a path that is just the filename of the file being referenced. Although the runtime application will check other file references, it will then be able to find the file in the same folder in which it resides. You can still keep any absolute or relative paths in the same file reference in case the files are also used in FileMaker Pro or FileMaker Pro Advanced.

To check file references:
2. If any file does not have a reference to the filename only, click New in the Define File References dialog box.
3. In the File Path List, type the filename, including the extension.
4. For File Reference Name, type a name. This is the name that will appear in all lists that display file references.
5. Click OK to save the file reference.

**Binding files for both platforms**

If your solution will be used in Windows, bind it using the Developer Utilities for Windows. If your solution will be used on Mac OS X, bind it using the Developer Utilities for Mac OS X. If you’re creating a solution to be used on both Windows and the Mac OS X, create two separate runtime solutions by binding the original solution files twice: first using FileMaker Developer Utilities for Windows, and then using FileMaker Developer Utilities for Mac OS X. Use the same binding key on both platforms. Also, remember that binding keys are case-sensitive.

**Binding databases into runtime database solutions**

Use the Developer Utilities to produce a stand-alone runtime database solution that users can access without running FileMaker Pro or FileMaker Pro Advanced. The Developer Utilities create a copy of your files, and bind the database file or files to a runtime application with a name that you specify.

None of the commands on the Define submenu opened from the File menu are available in the runtime application. See “Feature comparison of the runtime application with FileMaker Pro” on page 85. The FileMaker Pro Advanced features are also stripped from the runtime application.

A runtime database can, however, be opened in either FileMaker Pro or FileMaker Pro Advanced. The full functionality of these applications will be enabled, except if full access privileges have been removed. See “Removing full access privileges from databases” on page 73.

Runtime database solutions cannot be published over a network, the Internet, or an intranet unless you use FileMaker Pro or FileMaker Pro Advanced instead of the runtime application. For a complete list of the differences between the runtime application and FileMaker Pro, see “Feature comparison of the runtime application with FileMaker Pro” on page 85.

You may need to bind your database files several times before you prepare them for delivery to your users. When you have completed development and the final version is bound and ready to distribute, you should thoroughly test your runtime solution to ensure that it behaves as expected. See “Considerations for a runtime database solution” on page 66.

For information about what users need to use your runtime database solution, see chapter 8, “Distributing runtime database solutions” on page 75.
To bind database files into a runtime database solution:

1. Follow steps 1 to 9 in “Modifying database solution files” on page 64.

2. In the Specify Solution Options dialog box, select Create Runtime solution application(s).

3. For Runtime Name, type a name for your runtime application.
   The runtime name is used for the runtime application filename and for the name of the folder that contains the runtime database solution files. See “Choosing filenames for runtime database solutions” in the next section.

4. For Extension, type a three-character filename extension.
   The extension is used to associate the solution files with the runtime applications. See “Assigning three-character filename extensions” on page 69.

5. For Bindkey, type a key between 1 and 24 characters long.
   The binding key links the runtime application to the database files and ensures that the bound files will only open in the appropriate runtime application. See “Setting the binding key” on page 70.

   **Important** Binding installs system files pertaining to each platform.

6. To add a company logo or other custom image to the closing splash screen, click Specify, select the closing image, and click Select.
   The image should be at least 382 x 175 pixels (72 dpi) or higher, otherwise it will be distorted when displayed. The supported image formats are JPEG and GIF.

7. For Delay, set the number of seconds that you want the splash screen to display.
   You can preview the effect that your custom splash screen will have by clicking the Preview button.

8. Once you have specified options, click OK.

9. To be able to quickly repeat the process, click Save Settings, and choose a folder and location for your settings file.

See “Saving and reusing Developer Utilities settings” on page 71.

10. Click Create.

The Developer Utilities copy all of the runtime files to a new folder, created inside the Project Folder and named after the runtime solution. For information on bundling the necessary files and delivering your runtime database solution to your users, see “Distributing runtime database solutions” on page 75.

### Choosing filenames for runtime database solutions

Filenames can include up to 31 characters. When choosing filenames for runtime database solutions, consider the platforms on which your runtime solution will be used so your scripts and lookups will work properly.

Windows filenames must not start with a space. For cross-platform compatibility, do not use the following characters in filenames: quotation mark ("), slash (/), backslash (\), angle brackets (<>), asterisk (*), questions mark (?), colon (:), vertical bar (|).

### Assigning three-character filename extensions

The three-character filename extension associates all of the runtime solution files with the runtime application. If a user has more than one runtime database solution on a machine, the filename extension together with the binding key will ensure that the correct runtime application is started when a solution file is double-clicked. Use an extension that is unique to your users’ computer systems.
The Developer Utilities automatically update all files to use the three-character extension that you specify and append the extension to the filenames. Internal file references used in relationships, scripts, and external value lists are updated to interact with the new filenames. **Note** No matter what the filename extensions are, runtime database files can still be opened in FileMaker Pro and FileMaker Pro Advanced. To prevent users from modifying your runtime database solutions, create passwords for specific access privileges or select the Remove admin access from files permanently option in the Developer Utilities before you bind the files into a runtime database solution. See “Removing full access privileges from databases” on page 73.

**Assigning the extension for Windows solutions**
The three-character extension registers your runtime application with the Windows operating system. The extension is used by Windows to determine which application starts when you double-click a solution file. The Developer Utilities append the extension to all database filenames in the runtime database solution during the binding process.

**Assigning the extension for Mac OS X solutions**
In the Mac OS X, the three-character extension becomes the creator code for the runtime application. The creator code must be unique to ensure that the Mac OS X Finder can determine which application created each document. The creator code is stored in the solution files and in the runtime application.

Because creator codes are four characters, the Developer Utilities insert an uppercase “F” after the first character. For example, the default three-character extension “USR” becomes the “UFSR” creator code. Creator codes are case-sensitive. **Note** Creator codes should be registered with Apple Computer, Inc. to verify that the creator code you choose is unique. If the creator code is not unique, solution files might not open with the appropriate runtime application. You may use the USR three-character extension because FileMaker has registered the UFSR creator code with Apple Computer, Inc. Contact Apple Developer Support or visit their web site at www.apple.com to register any other creator codes.

**Conflicts with non-unique filename extensions in Windows**
If the three-character extension is not unique, it might cause registry conflicts in Windows. For example, if you use the .fp7 extension for your runtime database solution and your users have FileMaker Pro installed on their hard disks, all of their FileMaker Pro document icons will change to the runtime icons. Additionally, FileMaker Pro documents will no longer automatically open the FileMaker Pro application.

To restore the document icons to the original FileMaker Pro document icon:

1. Discard the runtime application.
2. Open a document in the FileMaker Pro application, then close it and exit the application.
3. Restart your computer.

**Setting the binding key**
The runtime name that you specify in the Developer Utilities is used for the name of the runtime application and can also be used for the name of the new solution folder that contains the bound runtime database solution files.

The binding key is a code that the Developer Utilities use during the binding process to internally link the files with the runtime application. If you need to add auxiliary files later to the existing runtime database solution, rebind the files using the same key.
When developing a solution for both platforms, use the same key when you bind the solution in Windows and in the Mac OS X. Also, keep in mind that the binding key is case-sensitive on both Windows and Mac OS X machines.

**Note** Use a binding key you’ll remember and record it in a safe place. (You can do this by saving the Developer Utilities settings file: see “Saving and reusing Developer Utilities settings” on page 71.) If you forget your binding key and want to change a runtime database solution, you’ll need to rebind all of the database files using a new binding key and then redistribute the entire solution, including a new runtime application.

### Modifying bound runtime files

You can open a bound runtime file in FileMaker Pro and FileMaker Pro Advanced to make modifications to it. However, if you selected the Remove admin access from files permanently option when you bound the files, then you can’t regain access to some features. See “Removing full access privileges from databases” on page 73. In this case, you’ll have to open the original database files in order to make design changes in FileMaker Pro Advanced and then rebind them using the binding key that you assigned to that runtime database solution.

See “Distributing updates to runtime database solutions” on page 83.

### Saving and reusing Developer Utilities settings

You can save the settings you specify in the Developer Utilities dialog box and reuse them again. The settings include the list of files to be modified. After you have entered your specifications in the Developer Utilities, click **Save Settings**. Choose a location and filename for the settings file. The extension .sav is automatically added and should not be changed. You can save as many settings files as you want, using different locations and names.

Use the Developer Utilities settings file to repeat the same processes on your database files with the Developer Utilities. When you open the Developer Utilities, click **Load Settings**, locate the settings file, and click **Load**.

### Modifying a set of solution settings

To modify a settings file:

1. Open the Developer Utilities.
2. Click **Load Settings**.
3. Locate and select the settings file that you want to modify.
4. Click **Load**.
5. Specify options.
6. Click **Save Settings**, then click **Save**.
7. Click Yes to replace the file.

Your alterations are saved and may be reused again.
Converting and upgrading solution files

If you have developed a FileMaker Pro runtime database solution using the Solutions Development Kit (SDK) for FileMaker Pro 3.0 or earlier, the Binder utility in the FileMaker Pro 4.0 Developer Edition, or the Developer Tool in FileMaker Developer 5.x and 6.0, you can upgrade your solution and provide your users with the converted files. Files bound to a runtime application using the earlier tools must be rebound using the Developer Utilities.

You must convert FileMaker Pro files created in version 6.0 or earlier to the new file format. You can convert a single file or convert multiple files at once. For more information about converting files, see the conversion information in the FileMaker Pro User’s Guide.

Once you have converted the files, you can upgrade them to take advantage of newer FileMaker Pro and FileMaker Pro Advanced features. If necessary, create scripts to import users’ existing data from the old runtime database solution into the new, upgraded solution. Use the Developer Utilities to bind the solution files into a new, upgraded runtime database solution. See “Binding databases into runtime database solutions” on page 68.

Distribute the new upgraded runtime database solution and provide instructions for how users can upgrade their files by converting the old files in the new runtime application and importing their data.

Importing data into upgraded runtime solutions

You can include scripts in the new runtime database solution files that allow users to import records from the old runtime files. The old files must first be converted to the new file format.

Note When creating your upgraded runtime solution, use a different extension than the one you used for your old runtime solution.

To prepare your upgraded solution for importing data:

1. Create a folder named “Old Solution Files” inside the folder that contains the new runtime solution database files.
2. Place copies of the old runtime solution database files in the “Old Solution Files” folder.
3. In each upgraded file, create a script to convert the old solution file and import records from it to the new file.

The functionality of the script should include:

- Convert File [<filename of the old version of the solution file>]
- Import Records [<old filename with the new solution’s extension>]
- Close File [<old filename with the new solution’s extension>]

4. Add a button to activate the script.
5. Repeat steps 3 and 4 for each upgraded file.
6. Use the Developer Utilities to bind your upgraded solution files into the new runtime database solution.
7. Test your buttons in the runtime application.

Use sample data to make sure the records import properly and data is imported to the correct fields.

8. Distribute the new solution files that contain the buttons.
9. Provide instructions telling users how to import data into the new solution files.

Users can copy their old files into the “Old Solution Files” folder and use the buttons in the new files to convert the old files and import records from them into the new solution files.
Removing full access privileges from databases

FileMaker Pro and FileMaker Pro Advanced use accounts, privilege sets, and extended privileges to protect FileMaker databases. You can use the Developer Utilities to remove all administrative accounts from a file. For more information about accounts and privileges, see Help. Use the Developer Utilities to prevent users from altering the design and structure of your database files and from changing any accounts or privileges that you’ve set up. If you enable the Remove admin access from files permanently option:

- Users can’t access these dialog boxes: Define Database, Define File References, Define Custom Functions, and most of Define Accounts & Privileges.
- The text version of custom functions is removed.
- Users can access the Extended Privileges tab in Define Accounts & Privileges if their account has the Manage extended privileges option enabled.
- Users can access the dialog boxes listed above if they run a script with the Run script with full access privileges option enabled.
- Users can access Layout mode and ScriptMaker if the privilege set assigned to their account permits it.

Note All database files must have at least one active account or they can’t be opened. You can’t use the Remove admin access from files permanently option if the accounts with Full Access privilege sets are the only active accounts in the file. If you attempt to do so, you will receive an error message.

Important Selecting this option permanently deletes from the database all accounts that were using the Full Access privilege set. This will permanently eliminate access to Layout mode and ScriptMaker, and all Define dialog boxes, except for the Extended Privileges tab of the Accounts & Privileges dialog box, for all database files in the solution, whether they’re opened in a runtime application, in FileMaker Pro, or in FileMaker Pro Advanced. Structural and design elements of the files cannot be modified by anyone, including FileMaker employees. The only way to modify the tables, field definitions, relationships, scripts, or access privileges is by returning to the original file before it was customized by the Developer Utilities.

Consider the long-term needs of your users when defining access privileges. Communicate their access privileges to them clearly in the About layout and follow the rules specified by FileMaker. For more information, see “Creating an About layout” on page 79.
Chapter 8
Distributing runtime database solutions

The final steps in developing your runtime database solution are to bundle all of the necessary files together, choose how you will distribute your solution—for example, on a CD-ROM or over a network—and provide your users with documentation for installing your solution. In addition, your documentation should include instructions for starting the runtime application and what to do if a file is damaged.

Organizing solution components

When you bind your database files into a runtime database solution, the Developer Utilities create a new solution folder and place the runtime application, the bound primary and auxiliary database files, and an Extensions folder inside it. For Windows runtime solutions there are also required Dynamic Link Library (DLL) files. These files and folders must not be renamed.

If your runtime database solution requires custom files, you should provide the files with the runtime files. Plug-ins should be stored in the Extensions folder. If a developer uses a font not found on a user’s system, the runtime application will make a font substitution. If a font is included with the runtime, provision should be made for its installation through the installer program. See “Using a custom installation program” on page 77.

In addition to the runtime files, you will need to provide installation instructions for your users. See “Documenting the installation procedures” on page 78.

Mac OS X runtime application package

The Developer Utilities generate a runtime application package for Mac OS X. The package will have the name that you give to your runtime solution. The runtime application package contains the core resources and code required for running the application. The contents of the package should not be altered, except to remove the language resource files. For more information, see “Reducing solution size” on page 76.

The package contains a Contents folder, which has information on the package and the Frameworks, MacOS, and Resources folders. The Resources folder includes the language resources folders (*.lproj). The package can be opened by using the Show Package Contents command.

The Extensions folder accompanies the Mac OS X package and contains the Dictionaries folder. The Dictionaries folder contains dictionary files (*.mpr) for all of the languages supported. The Dictionaries folder also contains a file for the user spelling dictionary (User.upr).
**DLL files for Windows runtime solutions**

The Developer Utilities generate a set of Dynamic Link Libraries (DLLs) during the binding process. These are in the solution folder along with the runtime application and bound database files. They must be delivered as part of the runtime solution. If any of these files are missing or become damaged, they must be replaced.

<table>
<thead>
<tr>
<th>DLL File</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBConverter.dll</td>
</tr>
<tr>
<td>DBEngine.dll</td>
</tr>
<tr>
<td>DOMSupport.dll</td>
</tr>
<tr>
<td>FML10.dll</td>
</tr>
<tr>
<td>FMLayout.dll</td>
</tr>
<tr>
<td>FMOLE.dll</td>
</tr>
<tr>
<td>FMRSRC.dll</td>
</tr>
<tr>
<td>FMScript.dll</td>
</tr>
<tr>
<td>FMUserModel1.dll</td>
</tr>
<tr>
<td>FMWrapper.dll</td>
</tr>
<tr>
<td>GdiPlus.dll</td>
</tr>
<tr>
<td>HBAM.dll</td>
</tr>
<tr>
<td>libeay32.dll</td>
</tr>
<tr>
<td>mfc71u.dll</td>
</tr>
<tr>
<td>MFCX.dll</td>
</tr>
<tr>
<td>msvc71.dll</td>
</tr>
<tr>
<td>msvcr71.dll</td>
</tr>
<tr>
<td>NSViews.dll</td>
</tr>
<tr>
<td>omniDynamic4.dll</td>
</tr>
<tr>
<td>omniORB4.dll</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DLL File</th>
</tr>
</thead>
<tbody>
<tr>
<td>omnipthread.dll</td>
</tr>
<tr>
<td>PlatformSupport.dll</td>
</tr>
<tr>
<td>ProofReader.dll</td>
</tr>
<tr>
<td>ssleay32.dll</td>
</tr>
<tr>
<td>Support.dll</td>
</tr>
<tr>
<td>XalanDOM.dll</td>
</tr>
<tr>
<td>XalanExtensions.dll</td>
</tr>
<tr>
<td>XalanSourceTree.dll</td>
</tr>
<tr>
<td>XalanTransformer.dll</td>
</tr>
<tr>
<td>XCore.dll</td>
</tr>
<tr>
<td>XDraw.dll</td>
</tr>
<tr>
<td>xerces.dll</td>
</tr>
<tr>
<td>XercesParserLiaison.dll</td>
</tr>
<tr>
<td>XFC.dll</td>
</tr>
<tr>
<td>XGrfx.dll</td>
</tr>
<tr>
<td>XMLEngine.dll</td>
</tr>
<tr>
<td>XMLSupport.dll</td>
</tr>
<tr>
<td>XPath.dll</td>
</tr>
<tr>
<td>XSLT.dll</td>
</tr>
<tr>
<td>XText.dll</td>
</tr>
</tbody>
</table>

**Extensions folder for Windows solutions**

The Extensions folder of Windows runtime solutions contains a folder for each language supported and a dictionaries folder. Each language resource folder contains a DLL file for the language (FMRSRC.dll), a file containing the text for the interface, dialog boxes, and error messages (FMStrs.dls), and a file containing the Windows language ID for the language (lang.dat).

The Extensions folder also contains the Dictionaries folder. The Dictionaries folder contains dictionary files (*.mpr) for all of the languages supported. The Dictionaries folder also contains a file for the user spelling dictionary (User.upr).

**Choosing a distribution method**

After you have organized the files that comprise your solution, you need to decide how your users will install them. You can distribute your bundled solution on a CD-ROM, over a network, or via the Internet.

**Reducing solution size**

If you are planning on distributing your runtime solution via the Internet, you may want to reduce the size of the solution before you package the solution. Deleting dictionaries and language resource files for languages not supported by your database will reduce the size of the application.

To reduce the size of your solution:

**Windows**

1. Open the Extensions folder that is copied to the runtime solution folder.
2. Delete language resource folders for languages not supported by your solution.

**Important** Do not delete the language resource folder for English.
3. Open the Dictionaries folder.
4. Delete dictionaries for languages not supported by your solution.

**Mac OS X**
1. Open the Extensions folder that is copied to the runtime solution folder.
2. Open the Dictionaries folder.
3. Delete dictionaries for languages not supported by your solution.
4. Control-click the runtime application package and choose Show Package Contents.
5. Locate the Resources folder in the Contents folder.
6. Delete language resource folders (*.lproj) for languages not supported by your solution.

**Using a custom installation program**
You should use a custom installation program to package your runtime solution for installation by users. Configuring a custom installation application to automatically install runtime database solution files may require more engineering than using a compression utility, but will help to ensure that your users do not have difficulties installing your runtime solution.

Here are some custom installation applications that you might want to use:
- MindVision Installer VISE (Windows and Mac OS X) by MindVision, Inc. (www.mindvision.com)
- InstallShield MultiPlatform (Windows and Mac OS X) by InstallShield Software Corporation (www.installshield.com)
- StuffIt InstallerMaker (Mac OS X) by Allume Systems, Inc. (www.allume.com)

**Using a compression utility program**
If your runtime database solution is not complex and you have confidence in the technical experience of your end users, you might consider a compression utility program rather than a custom installation program. To compress files, use a utility such as:
- StuffIt Deluxe (Windows and Mac OS X) by Aladdin Systems (www.aladdinsys.com)

**Sharing solutions over a network**
Users cannot share your runtime database solution over a network unless they access the files using FileMaker Pro or FileMaker Pro Advanced installed on their machines. You must have a master password to enable or change network access to the file. For optimal performance, you can host the solution files using FileMaker Server. For information about the FileMaker Server and FileMaker Pro products, and information about volume license sales, see the FileMaker web site at www.filemaker.com.

**What your users need**
In order to run your runtime database solution, your users will need the same minimum equipment and software required by the FileMaker Pro Advanced application. See the *Installation Guide for FileMaker Pro and FileMaker Pro Advanced*. In addition, your users will need instructions for installing and starting your solution, and information about how to recover damaged files.
Documenting the installation procedures

You’ll need to provide instructions to your users on how to install your runtime database solution. Here’s a list of things you should document:

- Provide written instructions for copying or installing your solution to your users’ hard disks.
- Include software and instructions specifying how your users can decompress your solution files.
- Include information about the minimum equipment and software requirements.

For suggestions on other information to include with your runtime database solution, “Providing user documentation” on page 79.

Starting runtime database solutions

After a user has run the installation program for your runtime application, the files are installed on the user’s hard drive. The solution’s three-character filename extension is registered with the operating system (Windows) or in the system preferences (Mac OS X). This registration allows the operating system to locate and launch the runtime solution if the user double-clicks the primary or auxiliary solution files. If a primary or auxiliary solution file is double-clicked before the runtime application has registered the extension, the runtime application won’t be found.

Important  Your users should start your solution by double-clicking the runtime application icon, not the primary file icon. Double-clicking the icons for the primary or auxiliary files might result in errors, depending on whether there are other copies of the runtime application on their hard disk. If your users have more than one solution on their computers with the same three-character extension and they double-click the icon for the primary file, the most recently installed runtime application is opened, which may not be the correct application for your solution’s primary file.

Each time the runtime application is opened, it looks for the primary file that has been bound to it. If the primary file can’t be found, the user is asked to locate the primary file.

Caution your users that they should not rename the primary or auxiliary solution files. If they do, relationships and external scripts may not work properly.

Note  When you make a change to your solution, make sure that your users can import their data into your updated solution. Include a script attached to a button to make it easy for your users to import their data into the new solution files. For more information, “Importing data into upgraded runtime solutions” on page 72.

Recovering damaged files

Power failures, hardware problems, or other factors can damage a FileMaker database file. If your database solution becomes damaged, your users will need to recover the damaged file. When the runtime application discovers a damaged file, a dialog box appears, telling the user to contact the developer. Even if the dialog box does not appear, files can become corrupted and exhibit erratic behavior.

Once you know which file is damaged, you can recover it using the Recover command, if you have FileMaker Pro or FileMaker Pro Advanced installed. If your user only has the runtime application, however, the Recover command does not appear in the File menu of the runtime application.
To recover a damaged file:

- On Windows machines, press Ctrl+Shift while double-clicking the runtime application icon. Hold the keys down until you see the Open Damaged File dialog box.
- On Mac OS X machines, press Option + ⌘ while double-clicking the runtime application icon. Hold the keys down until you see the Open Damaged File dialog box.

During the recovery process, the runtime application:

- creates a new file
- renames any damaged file by adding Old to the end of the filenames (for example, Contact Manager is renamed to Contact Manager Old)
- gives the repaired file the original name

If users experience unusual behavior in the recovered files, they should revert to a backup copy that was made before the file became corrupt, or contact you for technical assistance.

In your documentation, you should tell your users what to do after a file has been recovered. Tell your users to:

1. Recover the damaged solution file using the method described above for the type of computer they are using.
2. Open the recovered solution file in the runtime application.
3. Choose File menu > Save a Copy As.
4. In the dialog box, choose compacted copy (smaller) from the Save a (Windows) or Type (Mac OS X) drop-down list, name the file, and click Save.

Give the compacted file the same filename as the original file.
5. Make a copy of the original database and import the data from the recovered file into it.

---

**Providing user documentation**

You should provide documentation for your database solution, whether it is a database that must be opened in FileMaker Pro, FileMaker Pro Advanced, or a standalone runtime database solution. There are several ways that you can provide documentation for your solution, including a printed manual, an online Help system, and an About layout that is available from any layout in the solution.

Create custom About and Help layouts that document what your database solution is, how to use it, and where users can go for more information. Then use the custom menus feature to attach scripts to menu commands that open the About and Help layouts.

**Note** The FileMaker Pro and FileMaker Pro Advanced Help system is not available in runtime applications. However, Status bar Help (Windows) and Help tags (Mac OS X) are available.

**Creating an About layout**

For runtime database solutions, the FileMaker Pro Advanced license specifies that you must create an About layout that provides information for your users on how to contact you for technical support. FileMaker uses the About layout to distinguish databases created by developers using FileMaker Pro Advanced rather than users of FileMaker Pro.

For more information about what is required to appear in the About layout for runtime database solutions, see “Your responsibilities as a developer” on page 82.
To create an About layout:

1. Choose View menu > Layout Mode.
3. Type About <your solution> in the Layout Name box.
   
   **Note** For runtime database solutions, you must include the word “About” in the layout name. You must also include certain specific information in the layout. See “Your responsibilities as a developer” on page 82.

4. Select Blank Layout.
5. Click Finish.
6. Include in the layout your logo, other graphics, and your company information.
7. Include text that notifies users if the solution files are protected with passwords or if full access privileges have been removed.

See “Your responsibilities as a developer” on page 82 for the exact legal wording.

---

8. Create a button that lets your users return to the main layout of the primary file.
9. Choose Scripts menu > ScriptMaker and create a script that goes to the About layout.
   - Include the word “About” in the script’s name.
10. Use the Custom Menus feature to create a menu command that displays the About layout.

To display the About layout when the runtime application is started:

1. Open the primary file for the database solution.
2. Choose File menu > File Options > Open/Close.
3. Select Switch to layout and choose the About layout from the drop-down list.

**Creating a custom Help layout**

Create a Help layout that provides instructions for how to use your custom solution and add data to it. Then create a script in the primary file of your solution to display the Help system. Use the Custom Menus feature to make the script available as a command in the Help menu. In order for your custom Help menu to display on Mac OS, you must start with an empty menu. See “Creating and editing custom menus” on page 23.
Including printed documentation

In addition to an online Help system, you should include printed documentation that explains how to install your database solution and briefly how to use it in case users are not able to open your solution files.

Other items appropriate for printed documentation include:

- how to install your bundled solution
- how to install custom files
- how to upgrade to new solution files
- how to use your Help system
- how to start the database solution (see “Starting runtime database solutions” on page 78)
- what to do in case of a damaged file (see “Recovering damaged files” on page 78)
- how to reach you for technical support

You might also want to include the following recommendations:

- Tell your users not to rename any solution files (except the runtime application), or they may be unable to run your solution.
- Recommend that users back up their data regularly. You might want to automate some of the process by including scripts that save copies of the solution files. For more information, see Help.

Important In the event that your runtime database solution files become damaged, make sure users have access to your technical support email address or telephone number in your printed documentation or in a text file. If a database file is damaged, they may not be able to access the About layout in your solution to find out how to contact you.
Your responsibilities as a developer

FileMaker has established procedures for repairing files. If a customer complies with these procedures, then FileMaker may supply a repaired file to the customer.

If you distribute database files with passwords or you have removed full access privileges and do not want FileMaker to repair a file for a customer who requests this service, you must:

1. Notify your customers in writing and keep a record of such notice that your database solution contains passwords or data that can only be provided by you.

2. Every file in your runtime database solution must contain an About layout accessible from any layout in the database.

3. The layout name must begin with the word “About.”

4. The About layout must contain these items:
   - solution name
   - your company name and contact information
   - your support policy (for example, how and when you are available for technical support)

5. The About layout must contain this exact warning:
   “USER WARNING: This database solution contains password(s) that can only be provided by the Developer identified above.”

6. If full access privileges have been permanently removed from your database solution by selecting the Remove admin access from files permanently option in the Developer Utilities, then the About layout must contain this exact warning:
   “USER WARNING: This file is not customizable. Contact the above named Developer for information on customizing this database solution.”

The accounts and privileges protection in a FileMaker file should not be viewed as an absolute barrier that will prevent a customer from accessing files. FileMaker cannot guarantee that a customer will not be able to identify or bypass the password through third-party solutions or tools. Therefore, FileMaker recommends that you take appropriate steps to protect your consulting and development efforts without relying solely upon the password. For more information about accounts and privileges, see Help.

If you have a dispute with your customer, you must resolve this dispute directly with the customer. FileMaker is unable to, and will not, attempt to resolve such disputes.

Testing before and after creating your solution

You should verify the functionality of your database solution by testing it thoroughly before and after you customize it with the Developer Utilities.

To ensure the quality of your custom database solution:

- Verify every function and option in your solution. If you’re developing a solution for both platforms, test it on both Windows and Mac OS X platforms.
- Make sure your runtime database solution does not use a standard FileMaker Pro feature that is hidden or disabled in the runtime application. See “Feature comparison of the runtime application with FileMaker Pro” on page 85.
- Verify that all scripts and buttons work as expected. This is especially important if you’re displaying your solution in Kiosk mode. See “About Kiosk mode” on page 16.
- Verify your installation procedures and test other instructions in the documentation.
- Verify that your database layouts display well on monitors with different color capabilities and resolutions and on the smallest size monitor your users may be using.
Test your runtime database solution with actual data. This is especially important if users are upgrading from earlier versions of the runtime application and need to import data into new solution files.

- Make sure all the auxiliary files and DLLs (Windows) are present.
- Show your database solution to intended users to uncover any usability issues.
- Install your bundled database files on a completely different computer to verify that all the files associated with the primary file can be found.
- If you’re assigning passwords or permanently removing full access privileges, test all access levels. Make sure your database solution contains an About layout that notifies users of the level of access you’re providing. See “Creating an About layout” on page 79 and “Your responsibilities as a developer” on page 82.

**Important** You should keep an unbound version of any runtime database solution files, especially if you’ve permanently removed full access privileges. See “Removing full access privileges from databases” on page 73.

### Distributing updates to runtime database solutions

If you make feature enhancements or modifications to the primary bound file of your runtime database solution, you can distribute the updated file to your users without rebinding it. If you change the filename of the primary file, however, you’ll need to rebind the file and distribute a new version of the runtime application along with the updated file.

To distribute new or updated auxiliary files for your runtime database solution, you need to bind them first using the original binding key. If you are distributing a new auxiliary file that requires new file references in the main file or that requires other files to interact with it, you must update all files that have been modified.

If you forget the original binding key for your runtime database solution and want to update or add a file, you’ll need to rebind all of the database files with a new binding key and redistribute the entire solution.

To distribute an updated primary file:

1. Open the original primary file from your copy of the runtime solution in FileMaker Pro Advanced.
2. Make the changes to the primary file.
3. If necessary, create an Import script so users can import their existing data into the new primary file.

See “Importing data into upgraded runtime solutions” on page 72.

4. Send your users a copy of the new primary file with instructions to replace the old primary file in the runtime database solution folder.

To distribute a new or updated auxiliary file:

1. In FileMaker Pro Advanced, create the new auxiliary file or open the original auxiliary file (before it was bound) and make changes as required.
2. If necessary, create an Import script so users can import their existing data into the new file.

See “Importing data into upgraded runtime solutions” on page 72.

3. Use the Developer Utilities to rebind all of the files in the runtime database solution and include the new or updated auxiliary file. Use the same binding key that you used for the primary file. Remember that the binding key is case-sensitive. See “Binding databases into runtime database solutions” on page 68.

4. Send your users a copy of the new or updated auxiliary file along with instructions to place it in the runtime database solution folder, replacing the old file if appropriate.

As long as the binding key has not changed, you don’t need to redistribute the runtime application or other solution files.
Appendix A

*Feature comparison of the runtime application with FileMaker Pro*

When you double-click the FileMaker Pro application icon to start the application, the New Database dialog box opens and you can choose a database file. When you start a FileMaker Pro runtime application, the primary bound database file opens automatically.

Other key differences between the runtime application and FileMaker Pro include the following:

- All the database design features have been removed or hidden in the runtime application. These include the Define Database, Define Value Lists, Define File References, and Define Accounts & Privileges dialog boxes, Layout mode, and ScriptMaker.
- Custom functions and custom menus created with FileMaker Pro Advanced will work in the runtime application, although users of the runtime application cannot modify or create new custom functions or custom menus.
- Some other menu commands have been removed from the runtime application.

For example, you can’t use the runtime application to create, open, or close a database. (Bound runtime database files must contain a custom button or script to close or open other files. There is no close command on a runtime database window.)

- FileMaker Pro Help is not available in the runtime application. However, the Help menu and the Runtime menu can contain custom Help and About menu commands.
- Some tools are not available on the toolbars in Browse mode, Find mode, and Preview mode in the runtime application.
- External function plug-ins can be enabled in the Preferences dialog box.
- Although the XML Data filter appears as an option for the Convert File script step, you can’t convert XML files using this script step in a runtime application.
- FileMaker Pro File Sharing, serving a database on the web, or communicating with a Java applet requires FileMaker Pro or FileMaker Pro Advanced. You can, however, use a compatible version of FileMaker Server to serve runtime solution files.
- Apple events are supported but OLE automation is not supported in the runtime application on Windows machines.

*Application and document preferences*

In the runtime application, the following options are not available on the General tab of the Preferences dialog box:

- Show templates in New Database dialog checkbox
- Show recently opened files checkbox
The Layout tab is changed to the Color tab in the Preferences dialog box for the runtime application.

The File Options dialog box does not have the Open/Close and Text tabs in the runtime application, only the Spelling tab—as shown below.

---

FileMaker Pro Advanced Development Guide
## Toolbar comparison

The New Database and Open tools in the standard toolbar (in Browse mode, Find mode, and Preview mode) are not available in the runtime application.

The Help tool on the standard toolbar in the runtime application is dimmed unless a custom Help script has been specified.

The text formatting toolbar is the same for both the runtime application and FileMaker Pro.

![Toolbars in FileMaker Pro](image)

![Toolbars in a runtime application](image)

## Menu command comparison

The following tables show the menu commands that are available in FileMaker Pro (Pro) and in the runtime application (RT).

<table>
<thead>
<tr>
<th>File Menu command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Database</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open Remote</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open Recent</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Close</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Define</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>File Options</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
</tbody>
</table>

### Windows

| Change Password | ■ | ■ | ■ | ■ |
| Print Setup     | ■ | ■ |
| Page Setup      | ■ | ■ | ■ |
| Print           | ■ | ■ | ■ | ■ |
| Import Records  | ■ | ■ | ■ | ■ |
| Export Records  | ■ | ■ | ■ | ■ |
| Save/Send Records As | ■ | ■ | ■ | ■ |
| Send Mail       | ■ | ■ | ■ | ■ |
| Save a Copy As  | ■ | ■ | ■ | ■ |
| Recover         | ■ | 1 | ■ | 2 |
| Exit            | ■ | ■ |

### Notes
1. Press Ctrl+Shift
2. Press Option+\[3

---

**Note**  You can add menu items that mimic Open, Close, and Recover menu commands to a runtime application using custom menus based on a script or script step. For more information, see “Customizing menus” on page 21.
<table>
<thead>
<tr>
<th>Edit Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Clear</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Select All</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Find/Replace</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Spelling</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Object</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Export Field Contents</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Sharing</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Preferences</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Browse Mode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Find Mode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Layout Mode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Preview Mode</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Go to Layout</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>View as Form</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>View as List</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>View as Table</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Toolbars</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Status Bar</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Status Area</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Text Ruler</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Zoom In</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Insert Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Picture</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>QuickTime</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Sound</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>File</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Object</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Current Date</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Current Time</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Current User Name</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>From Index</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>From Last Visited Record</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Font</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Size</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Style</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Align Text</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Line Spacing</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Text Color</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Text</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
## Appendix A  Feature comparison of the runtime application with FileMaker Pro

<table>
<thead>
<tr>
<th>Records Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>New Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Found Records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Omitted Only</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Record</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Multiple</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Last Find</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort Records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unsort</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace Field Contents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relookup Field Contents</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert Record</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Requests Menu command (Find mode)</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Add New Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Request</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to Request</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Requests Menu command (Find mode)</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>Show All Records</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perform Find</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Constrain Found Set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extend Found Set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert Request</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scripts Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>ScriptMaker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Script names&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Window Menu command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pro</td>
<td>RT</td>
</tr>
<tr>
<td>New Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimize Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Vertically</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade Windows</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bring All To Front</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Names of open files&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Because some features have been removed from the runtime application, the following script steps are ignored by the runtime application:

- Open Define Database
- Open Define Value List
- Open Define File References
- Open Sharing
- Open ScriptMaker
- Open Help (executes custom Help script specified during binding)
- Set Multi-User
- New File
- Open File Options (partially available; Spell checking tab will open)
- Open Remote
- Execute SQL
- Save Records as PDF
- Perform External Script (if the specified file has not been bound to the runtime application)
- Open File (if the specified file has not been bound to the runtime application)

**Stored registry settings or preferences**

**Windows registry settings**
FileMaker Pro stores its registry settings at

HKEY_CURRENT_USER\Software\FileMaker\FileMaker Pro\8.0

FileMaker Pro Advanced stores its registry settings at

HKEY_CURRENT_USER\Software\FileMaker\FileMaker Pro\8.0A

The runtime application stores its registry settings at

HKEY_CURRENT_USER\Software\FileMaker\<solution name>\8.0

**Note** The filename extension for the runtime database files is registered at HKEY_CLASSES_ROOT

**Mac OS X preferences**
FileMaker Pro stores its preferences in the FileMaker Pro 8.0 Prefs file inside the FileMaker Preferences folder.

FileMaker Pro Advanced stores its preferences in the FileMaker Pro 8.0A Prefs file inside the FileMaker Preferences folder. The runtime application stores its preferences in the <Solution name> 8 Prefs file inside the FileMaker Preferences folder.
Index

A

About layout 10
  creating 80
  required contents of 82
access keys, custom menus 22, 25, 26
access privileges 65, 82
accounts and privileges 73, 82
Adjust Window script step 18, 56
administrative accounts
  removing from a file 73
Allow User Abort script step 56
ampersand (&) character entity 34
apostrophe (’) character entity 34
Apple Computer, Inc. 49, 70
Apple events in runtime applications 85
Apple Xcode 43
Application menu commands available in runtime applications 90
ASCII characters
  in plug-in IDs 49
  in theme names 38
auxiliary files
  opening 66
  problems with double-clicking icons 78
  updating 83

B

backing up your original files 64
binding 68
  cross-platform solutions 68, 71
binding key
  setting for runtime database solutions 70
  updating runtime database solutions 83
body layout parts 35
breakpoints, script 56
Browse mode, in runtime applications 85
buttons, creating dynamic 18

C

C/C++ 43
color palette 40
color values for layout themes 40
commands, menu
  available in runtime applications 87
  customizing 21
  removing access to 73
compacting files 60
compression utilities for runtime databases 77
configuring plug-ins 50
Contents folder (Mac OS X) 75
converting files from previous versions 64, 72
copying
  fields 12
  script steps 12
  scripts 12
  tables 13
creator codes 70
cross-platform solutions 68
custom functions 14
  creating 14
  deleting 16
  disabling the display of 14
  duplicating 16
  editing 15
  naming 14
custom menus
  about 21
  About menu for runtime solutions 30
  access keys 22, 25, 26
  creating 23
  documenting 22
  editing 23
  example 21
  Help menu for runtime solutions 30
  impact on features 22
  installing 29
  menu items 24
  menu sets 27, 29
  Script menu for runtime solutions 30
  terminology 22
  testing 30
  toolbars 26
customer support
  for FileMaker Pro Advanced 9
  for runtime solutions 79
cross-platform solutions
  about 68

damaged runtime files, recovering 79
Data Viewer 57
Database Design Reports 59
database schemas 59
database statistics 59
database structure, recreating 59
DDR. See Database Design Reports
debugging. See troubleshooting
defragmenting files 61
delay, splash screen 69
Developer Utilities 63
  saving settings 71
dictionaries 67
  deleting 77
Dictionaries folder 75, 76
disabling script steps 58
distributing runtime database solutions about 75
   distributing updates 83
   methods 76
   terms and conditions 10
   Do PluginInit function 51
documenting
   custom menus 22
   Database Design Reports 59
   database solutions 79, 81
   external function plug-ins 53
   installation of runtime databases 79
Dynamic Link Libraries (DLLs) 75, 76

E
Edit menu commands available in runtime applications 87
electronic documentation 9
   elements in layout themes 33
   emulating interface elements 18
   Enter Browse Mode script step 16, 18
   Enter Find Mode script step 18
   Enter Preview Mode script step 18
   error log 66
   Execute SQL script step 90
   expressions, monitoring 57
   extended privileges 73
   Extensible Markup Language (XML). See XML
   Extensions folder 75
      location for plug-ins 45
   extensions, filename. See filename extensions
   External Function message sent to plug-ins 52
   external function plug-ins 43
      documenting 53
      enabling 45
      in runtime applications 85
      messages sent by FileMaker Pro 50
      plug-in ID 50
   external functions 43

F
fields, monitoring 57
File Maintenance feature 60
   Compact File option 60
   Optimize File option 60, 61
File menu commands available in runtime applications 87
File Options available in runtime application 86
   file references 67
   FileMaker Developer. See FileMaker Pro Advanced
   FileMaker Pro Advanced
documentation 8
   license agreement 10
   new features 8
   product overview 7
   upgrading from earlier versions 72
FileMaker Pro, menus available 87
FileMaker Server 43, 77, 85
filename extensions
   for database files 65
   for runtime databases 69
   plug-ins 45
   registered by runtime applications 78
   registry conflicts (Windows) 70
files
   closing in Kiosk mode 16
   compacting 60
   compressing runtime 77
   converting 64, 72
   naming 69
   optimizing 61
   recovering damaged 79
   renaming 64
   specifying for Developer Utilities 64
Find mode, in runtime applications 85
FMExample plug-in 46
fmplugin filename extension 45
fmx filename extension 45
folder structure
   example plug-in 44
   solution 67, 75
fonts 31, 38
   not on user’s system 75
footer layout parts 35
Format menu commands available in runtime applications 88
fragmented files 61
full access privileges
custom functions 14
   custom menus 23
   Database Design Reports 59
   removing from files 73
functions
   custom 14
   external 43

G
GetString message sent to plug-ins 52
greater than (>) character entity 34

H
header layout parts 34
Help
   custom menus 27
   menu commands available in runtime applications 90
tags. See tooltips
tool on toolbar in runtime applications 87
Help layout for runtime solutions 81
hexadecimal (hex) values for layout themes 40
HTML format for Database Design Reports 59

I
icons for runtime solutions 78
Idle message sent to plug-ins 52
Import.log file 12, 13
Index

importing records 72  
See also copying tables 13
Initialization message sent to plug-ins 50
Insert menu commands available in runtime applications 88
install 10
installation code. See license key
installation instructions 9  
for runtime database users 78
installers for runtime databases 77
installing custom menus 29
InstallShield 77
interface elements, emulating 18
Internet databases on 9
runtime applications on 68

J
JDBC, using with FileMaker products 9

K
key, binding 70
keyboard shortcuts. See shortcuts
Kiosk mode 16
  centering database windows 18
  closing files 16
  enabling 17
  example Help screen 80
  preparing databases for 16

L
language resource folders, runtime databases (Windows) 76
Layout mode commands  
  unavailable in runtime applications 85
  unavailable to FileMaker Pro Advanced 73
layout objects, tooltips 11
layout parts 34
layout themes
  attribute values 37
  attributes for single-line elements 36
  basic requirements 33
  checking for errors 41
  color values 40
  comment tags 41
  creating 31
  default values 40
  elements for layout parts 34
  elements for layout text 35
  modifying 31
  multi-line elements 34, 35
  pattern values 40
  single-line elements 34, 35
leading grand summary layout parts 35
leading subsummary layout parts 35
legal requirements 10
less than (<) character entity 34
license agreement 10
license key 10
logo, adding to runtime solution 69

M
Mac OS X
  creator codes 70
  resource conflicts 52
  runtime application package 75
  stored preferences 91
menu commands  
  available in runtime applications 87
  customizing 21
  removing access to 73
menu item customization 24
menu separators 25
menu sets
  creating 27
  defined 22
  editing 27
  installing 29
  specifying default 29
messages
  error log 66
  sent to external function plug-ins 50
Microsoft Visual Studio .NET 43
Microsoft Windows
  runtime application components 76
  stored registry settings 91
MindVision Installer VISE 77
minimum requirements, runtime database solutions 77
Move/Resize Window script step 18
multi-line XML elements for layout themes 34
multiple database files 64
multiple tables per database file 63, 67

N
naming runtime database solutions 69, 70
navigating in Kiosk mode 16
New Database tool 87
New File script step 90
New Layout/Report assistant 31, 33

O
ODBC, using with FileMaker products 9
OLE automation in runtime applications 85
Open Define Database script step 90
Open Define File References script step 90
Open Define Value List script step 90
Open File Options script step 90
Open File script step 91
Open Help script step 90
Open Preferences script step 18
Open Remote script step 90
Open ScriptMaker script step 90
Open Sharing script step 90
Open tool 87
opening files in runtime applications 66, 68
runtime databases in FileMaker Pro and FileMaker Pro Advanced 70, 71
optimizing files 61
option string syntax for plug-ins 49
package, runtime application (Mac OS X)  75
page margins  67
parts, layout  34
passwords  70, 80
required warning in About layout  82
paths, file  67
pattern palette  40
Pause/Resume Script script step  16
Perform External Script script step  91
performance, improving  60
plug-ins
configuring  45, 50, 52
example project  43
function name prefix  50
IDs  49, 50, 53
in runtime applications  85
installing  45
installing web publishing plug-ins  45
preparing  43
registering with Apple  49
registering with FileMaker  43, 53
required option string syntax  49
resource ID conflicts (Mac OS X)  52
revising registration  53
preferences available in runtime application  85
Preferences message sent to plug-ins  52
Preview mode
in runtime applications  85
script step  16
primary file  64
connecting auxiliary files  63
icon  78
in Kiosk mode  16
problems with double-clicking icon  78
updating  83
Print script step  18
printing from runtime applications  67
privilege sets  13, 16, 23, 27, 55, 58, 73
privileges, extended  73
Project Folder  69
and the Developer Utilities  66
Q
quote (" ) character entity  34
R
Records menu commands available in runtime applications  89
recovering damaged runtime files  79
references, file  67
registering
FileMaker Pro Advanced  9
plug-in IDs  49
registry
conflicts with filename extensions  70
stored settings  91
renaming
files  64
reports, database  59
Requests menu commands available in runtime applications  89
requirements for About layouts  82
restoring document icons (Windows)  70
revising registered plug-ins  53
runtime applications
available menu commands  87
compared to FileMaker Pro  85
enabling plug-ins in  85
icon  78
ignored script steps  90
stored Mac OS X preferences  91
stored Windows registry settings  91
toolbars available  87
runtime database solutions
About layout requirements  79, 82
converting  72
creating  63, 68
documenting installation  79
importing records  72
naming  69
opening files in  66
preparing files  63
printing reports  67
recovering damaged files  79
required DLL files (Windows)  76
size  76
spell checking  67
updating  83
upgrading  72
S
sav filename extension  71
Save Records as PDF script step  90
saving Developer Utilities settings  71
schemas, database  59
screen tips. See tooltips
Script Debugger  55
access privileges necessary to run  55
buttons and commands  56
overriding script steps  56
running scripts in debug mode  55
viewing sub-scripts  56
script steps, disabling  58
ScriptMaker commands
unavailable in runtime applications  85
unavailable to FileMaker Pro Advanced  73
scripts
attaching to About and Help commands  79
copying  12
debugging  55
for changing menu sets  30
for emulating menu commands and window controls  18
for navigating in Kiosk mode  16
for opening runtime databases  66
steps ignored by runtime applications  90
Scripts menu
   commands available in runtime applications 89
Scroll Window script step 18
set Multi-User script step 90
Set Zoom Level script step 18
settings file 71
shortcuts
   custom menus 26, 27
   customizing 26
   defined 22
   menu item 26
Script Debugger 55
Show Package Contents command
   (Mac OS X) 75
Show/Hide Status Area script step 18
Shutdown message sent to plug-ins 51
single-line XML elements for layout themes 34
size
   of database files 60
   of solutions 76
Solutions 72
solutions. See runtime database solutions
Sort Records script step 18
spell checking in runtime solutions 67
splash screen in runtime solutions 69
startup scripts
   to display custom layout 68
statistics, database 59
status bar Help (Windows) 79
structure, database 59
StuffIt 77
submenus 22, 25

T
   tables, database
      excluding from Database Design Report 59
      multiple per file 63
TechInfo Knowledge Base 9, 10
technical support
   for FileMaker Pro Advanced 9
   for runtime solutions 10, 79
testing
   custom menus 30
database solutions 82
text editors 31
themes. See layout themes
title footer layout parts 35
title header layout parts 34
toolbar
   custom menus 26
   FileMaker Pro 87
   runtime application 87
tooltips 11
touch screen, Kiosk mode 16
trailing grand summary layout parts 35
trailing subsummary layout parts 35
troubleshooting
calculations 57
   custom menus 30
   fields 57
   Script Debugger 55
   using Database Design Reports 60
   variables 57

U
   updates, distributing 83
   upgrading runtime databases 72
   user interaction with database solution 63
   user spelling dictionary 75, 76

V
   variables, monitoring 57
   View menu commands available in runtime applications 88
   volume license 10

W
   web 70
   web browser users 9
   web-safe colors 37, 40
   Window menu commands available in runtime applications 89
   WinZip for Windows 77

X
   XML
      character entities 34
documents for layout themes 31
      editors 31
      format for Database Design Reports 59
      XML 1.0 specification 33
      XML-document processing instruction 33